MathType
Mathematical Equation Editor
USER MANUAL
# Table of Contents

## Chapter 1: Introduction
- About MathType ................................................................. 1
- Using this Manual .............................................................. 2
- Additional MathType Documentation ................................. 3
- Getting Help ........................................................................ 4
- Registering Your Copy of MathType .................................... 4

## Chapter 2: Getting Started
- Overview ............................................................................ 5
- System Requirements ........................................................ 5
- Installing MathType ............................................................ 5
- What to do Next ................................................................... 6
- Notes for Users of Earlier Versions of MathType ................. 6
- Notes for Microsoft Equation Editor Users ......................... 7
- Equation Conversion Manager ............................................ 7

## Chapter 3: Basic Concepts
- Introduction ........................................................................ 9
- The MathType Window ..................................................... 10
- Keyboard Notation in this Manual .................................... 12
- Entering Text from the Keyboard ..................................... 12
- Inserting Symbols ............................................................. 13
- Inserting Templates .......................................................... 14
- Placing the Insertion Point ................................................. 14
- Moving the Insertion Point ............................................... 15
- Selecting Items in an Equation .......................................... 16
- The ENTER Key .................................................................. 16
- Keyboard Shortcuts ......................................................... 37

## Chapter 4: Tutorials
- Before You Start .................................................................. 19
- Tutorial 1: Fractions and Square Roots ............................ 20
- Tutorial 2: Sums, Subscripts & Superscripts ...................... 23
- Tutorial 3: Editing Old Equations ...................................... 26
- Tutorial 4: Including Text in an Equation .......................... 28
- Tutorial 5: Using MathType’s Toolbar .............................. 30
- Tutorial 6: Spacing and Alignment .................................... 34
# Table of Contents

## Chapter 7: Advanced Formatting
- Introduction ................................................................. 85
- Overriding Automatic Spacing ....................................... 85
- Nudging ........................................................................... 86
- Fence Alignment ........................................................... 87
- Changing the Font of Individual Characters ..................... 88
- Changing the Size of Individual Characters ....................... 89
- Choosing Fonts for Math Documents ................................. 89
- Fonts as Sources of Additional Symbols ............................ 90
- MathType’s Font and Character Knowledge ......................... 91
- Tabs .................................................................................. 93

## Appendix A: Font Charts
- MathType’s Fonts ............................................................ 95
  - Symbol, plain .............................................................. 96
  - MT Extra, plain .......................................................... 97
  - Euclid Symbol, plain ................................................... 98
  - Euclid Symbol, italic ................................................... 99
  - Euclid Symbol, bold .................................................... 100
  - Euclid Symbol, bold-italic ........................................... 101
  - Euclid, plain .............................................................. 102
  - Euclid, italic .............................................................. 103
  - Euclid, bold .............................................................. 104
  - Euclid, bold-italic ....................................................... 105
  - Euclid Extra, plain ...................................................... 106
  - Euclid Extra, bold ....................................................... 107
  - Euclid Fraktur, plain .................................................... 108
  - Euclid Fraktur, bold ..................................................... 109
  - Euclid Math One, plain ............................................... 110
  - Euclid Math One, bold ............................................... 111
  - Euclid Math Two, plain ............................................... 112
  - Euclid Math Two, bold ............................................... 113

## Index

---

iii
Chapter 1
Introduction

About MathType

MathType™ is an intelligent mathematical equation editor designed for personal computers running Microsoft Windows or the Apple Macintosh OS. It’s an application that allows you to create complex equations through simple point-and-click techniques, and then use them in documents, web pages, or markup-based systems like \texttt{LaTeX}. Using MathType in conjunction with a word-processing, page-layout, or graphics application, you can easily create tests and class notes, technical reports, view-graphs, research papers, dissertations, slides, and even entire books. MathType is also the full-featured version of the Equation Editor that comes with Microsoft Word, Corel WordPerfect, and many other popular applications and provides a seamless upgrade to the capabilities found in Equation Editor.

MathType’s User Interface

As with most Windows applications, the MathType user interface is intuitive and very visually oriented. For each basic mathematical construct, MathType provides a template containing symbols and various empty slots. There are around 175 templates in all, including fractions, radicals, sums, integrals, products, matrices, and various types of brackets and braces. You create equations simply by inserting templates and filling in their slots. You can insert templates into the slots of other templates, so complex hierarchical formulas can be built up in a natural way.

In addition, MathType provides on-screen icons for over 214 special mathematical symbols, many of which are unique to MathType and are not available in the standard Symbol font. You can insert these symbols into an equation simply by clicking on them — you don’t need to remember anything about fonts and keystroke combinations.

You can easily modify MathType’s user interface to speed up your work. It provides a set of customizable toolbars on which you can place templates, common equation fragments, or any character from any font on your computer. Then you can insert these items into your equations with just a single click.

Any of MathType’s symbols and templates, and most of its other commands and operations, can also be accessed via the keyboard, rather than the mouse. You can even design a custom keyboard layout to fit your own way of working.
Intelligence
MathType is intelligent in the sense that it understands mathematics and the established rules of mathematical typesetting. For example, it automatically resizes square root signs and parentheses to fit their contents, inserts appropriately sized spaces around mathematical operators and relational symbols, and displays standard mathematical abbreviations like \( \lim \), \( \log \) and \( \sin \) in an appropriate style.

This built-in intelligence frees you from having to worry about many of the details of equation layout; it improves the consistency of your work and saves a considerable amount of time, both in the initial creation of equations and in subsequent proof-reading.

Cooperating with Other Applications
MathType can work with a wide range of document processing applications. The optimal method of incorporating equations into your documents depends on what kind of document you need to create. MathType equations can be integrated into documents in several ways:

- Using standard Cut-and-Paste or Drag-and-Drop techniques.
- Using an application’s Insert Object command (Object Linking and Embedding, also known as OLE).
- Equations can be converted into \( \text{\LaTeX} \), \( \text{\LaTeX} \), MathML, or other textual languages using a customizable translation mechanism.
- Equations can be saved in files in Windows Metafiles (WMF), Encapsulated PostScript (EPS) format, or GIF format, ready to be imported into documents.

Chapter 5 provides more detailed advice about the various methods for importing equations into documents.

Equations that you have transferred into documents can be brought back into MathType for editing or reuse. You can do this using Cut-and-Paste commands, or in Windows applications that support OLE, double-clicking an equation brings it into MathType automatically.

Using this Manual
This manual was written assuming that you understand the basic operation of your computer and the Windows environment. You should be familiar with concepts such as mouse clicking, dragging, scrolling, and so on. Please refer to your Windows manual or online Help if you need to refresh your memory.

MathType has a very intuitive user interface, and you can probably learn its basic capabilities just by experimenting with it. However, reading this manual can cut down on the learning time needed to become productive. Some of MathType’s
most powerful features are best discovered and understood by reading about them first. We’ve also provided many hints and shortcuts that will enable you to get the most benefit from MathType in the shortest possible time.

If you want to gain a sound understanding of MathType and get the most out of it, you should consider reading most of the material in the next four chapters of this manual. The purpose of each chapter is as follows:

**Chapter 2: Getting Started**
Tells you how to install MathType. You should read this chapter.

**Chapter 3: Basic Concepts**
Describes the fundamental ideas and techniques used in MathType and the tutorial examples in the next chapter. You should at least glance through this chapter.

**Chapter 4: Tutorials**
Provides step-by-step instructions for working through some simple examples. Some of the tutorials cover basic concepts and are the easiest way to learn MathType — we highly recommend that you take a few minutes to work through them. Other tutorials are more advanced and are useful whenever you need a step-by-step introduction to one of MathType’s more powerful features.

**Chapter 5: Using MathType with Other Applications**
This chapter recommends techniques for using MathType with other applications. You should read this chapter to learn about the different ways of incorporating MathType equations into your documents.

**Chapters 6: Fonts, Styles, Sizes, and Spacing**
This chapter covers MathType’s automatic formatting and its system of styles, sizes, and spacing. You should read this chapter to learn how to use MathType’s preference files to give your equations a consistent look.

**Chapters 7: Advanced Formatting**
Read this chapter to learn the finer points of mathematical typesetting in MathType. You will also learn how to override MathType’s automatic formatting, if necessary.

**Additional MathType Documentation**
Like most good Windows programs, MathType has online help documentation that can be viewed using the commands on its Help menu. MathType Help is not a substitute for this manual, but provides specific information regarding menu commands and dialog items, and contains troubleshooting assistance for common problems.
While we have tried to make this manual complete and accurate, there may be new information that was not available to us when this manual was written and printed. Use the MathType Read Me command on the Windows Start or Programs menu to see important last-minute information and revisions to this manual. In addition, the MathType World Wide Web site at [www.mathtype.com](http://www.mathtype.com) contains a Technical Support section with articles on:

- Working with specific applications that are not covered in this manual, especially those that were released or updated after this manual was written.
- Troubleshooting problems that were discovered after this manual was written.
- How to extend MathType’s knowledge of fonts, symbols, and math languages.

## Getting Help

We hope that this manual tells you everything that you need to know about MathType, but it is difficult to foresee every possibility. If you have questions, we request that you first refer to this manual and the online help. If you fail to find the information you need, or you would like to suggest improvements or new features, please feel free to contact us.

Although we offer free telephone support, email is usually the best way to get your questions answered. You can reach us by mail, by phone (Monday through Friday, 8 a.m. to 5 p.m., Pacific time), FAX, or electronically, as follows:

Design Science, Inc.
4028 Broadway
Long Beach, CA 90803
Phone: (562) 433-0685
Fax: (562) 433-6969
Technical Support support@mathtype.com
Email: info@mathtype.com
Web site: [www.mathtype.com](http://www.mathtype.com)

Please include your MathType registration number in any communication. You can find this using the About MathType command on MathType’s Help menu.

### Registering Your Copy of MathType

If you are a new MathType user, please use the Register MathType command on MathType’s Help menu (or send in the registration card that came in the MathType package), so that we can inform you about upgrades, complementary products, and other important information as they become available.
Chapter 2  Getting Started

Overview

This chapter describes the steps you need to go through to get MathType up and running and provides helpful information if you are upgrading from our Equation Editor product or a previous version of MathType.

MathType's system requirements and installation instructions are listed below. Although installing MathType is simply a matter of running its Setup program and following a few simple instructions, you may want to read this chapter first so you have a better understanding of MathType and its components.

System Requirements

In order to install and run MathType, your computer must have:

- Microsoft Windows 95, Windows 98, Windows NT 4.0 or later.
- A hard disk drive with at least 10 megabytes of free space.

MathType does not require a great deal of memory (RAM) or processor power. If you have enough RAM to run Windows, you have enough to run MathType.

Installing MathType

Installing MathType is very simple — just run MathType's Setup program and follow its instructions.

If You Purchased MathType Online

If you purchased MathType from our web site, you have probably already run MathType Setup. In case you have not, run the file you downloaded (MTW4xxx.EXE, where xxx is the version number) and follow the instructions.

If You Purchased MathType on CD-ROM or Floppy Disks

If you are installing MathType from a CD-ROM, MathType Setup will usually start automatically when you insert the CD-ROM into the drive. If it doesn’t, or you are installing from floppy disks, run SETUP.EXE and follow the instructions. This file is in the MathType folder on the CD-ROM, and on floppy disk #1. You can run it using the Run command on the Start menu, or the Windows Explorer.
MathType User Manual

MathType Setup

Once you have started MathType Setup, just follow the instructions presented to you. Setup will install the following components:

- The MathType application.
- All of its fonts, in TrueType and PostScript formats.
- Support for Microsoft Word 95, 97, 2000 and later.
- Support for Microsoft PowerPoint 97, 2000 and later.
- A “MathType 4” submenu will be added to the Programs submenu of the Windows Start menu.

What to do Next

Now that you’ve installed MathType, you’re probably ready to start creating equations. But, if you have a few minutes, you might want to look over the rest of this chapter, especially if you are upgrading from Equation Editor or an earlier version of MathType.

Once you have finished with this chapter, you have two choices as to what to do next. If you want to understand the basic ideas behind MathType, read Chapter 3. The various elements shown in the MathType window are all described there. On the other hand, if you’re an experienced Windows user, and you’re feeling impatient and impetuous, you can turn to Chapter 4 and start working through the quick and easy tutorials. MathType is very simple and intuitive, and adheres closely to Windows user interface standards, so you will probably get the hang of it fairly quickly. In the unlikely event that something seems a little strange or confusing, you can always go back and read Chapter 3 or consult MathType’s online help.

Notes for Users of Earlier Versions of MathType

MathType 4 effectively replaces earlier versions of MathType as the application used for editing equations. However, MathType’s installation program does not delete older versions of MathType (unless you install it into the same folder on your hard disk), but simply registers itself as the editor for equations you have already created using the older versions. If you want to change this behavior or fine-tune it, see the “Equation Conversion Manager” section later in this chapter.

Unlike earlier versions, MathType 4 requires fonts that are available for screen display (i.e. PostScript fonts, if you have Adobe Type Manager, or TrueType fonts) — printer-only fonts are not supported. Your word processor may allow you to use printer-only fonts but, as MathType is very font-intensive, it cannot use these fonts without sacrificing precision and quality.
Notes for Microsoft Equation Editor Users

Once MathType is installed, it effectively replaces Equation Editor as the application used for editing equations. However, MathType’s installation program does not delete the Equation Editor application, but simply registers itself as the editor for equations you have already created with Equation Editor (and earlier versions of MathType). If you want to change this behavior or fine-tune it, see the “Equation Conversion Manager” section below.

Equation Conversion Manager

Over the years, Design Science has produced several versions of MathType and has licensed several versions of Equation Editor to many other software companies, including Microsoft. You may already have one or more of these installed on your computer now. Every equation is marked with the version of MathType or Equation Editor that was used to create it. You can see this information when, for example, you select an equation in a Microsoft Word document. Word’s status bar near the bottom of the screen will show something like, “Double-click to Edit MathType 4 Equation”.

MathType Setup automatically registers MathType 4 as the editor for equations created by all earlier versions of MathType and Equation Editor. This has two effects:

• When you double-click on an existing equation, MathType 4 will be used to edit it and the equation will automatically be converted to a MathType 4 equation.

• Other versions of MathType and Equation Editor will no longer appear in the list of insertable objects in your word processor’s Insert Object dialog.

This is usually what you want to happen, as MathType 4 is more powerful than those other equation editors. However, if this is not what you want to happen, you can use MathType’s Equation Conversion Manager to modify this behavior. You must exit MathType before running the manager. The Equation Conversion Manager command is in the MathType 4 submenu, which is located in the Programs submenu in Windows’ Start menu.

The manager is quite simple to use — if you are not sure what to do, click on the dialog’s Help button for more details.
Chapter 3
Basic Concepts

Introduction

This chapter outlines the basic concepts used in MathType. If you are an experienced Windows user, you will be familiar with some of them already, since they are common to many Windows applications. On the other hand, the symbol and template ideas are unique to MathType, so you may want to read a little about them.

The basic purpose of MathType is to allow you to create and edit mathematical equations. In this manual, we use the term “equation” to refer to any combination of mathematical symbols. The approach to equation creation is very intuitive and visually oriented. For each basic mathematical construct, like a fraction or an integral, MathType provides a template containing various symbols and empty slots. You build equations simply by inserting templates and then filling in their slots. Chapter 4 explains the techniques in detail.

You will generally be placing MathType equations into a document you’re creating with a word processor (or a page layout application, or a similar program). You’ll want to run MathType and your word processor simultaneously, and transfer equations into and out of your document. Chapter 5 explains several ways to do this.
The MathType Window

The picture below shows MathType with all parts of its toolbar visible:

Within the equation area itself, there are four items of interest:

**Empty Slot**
A slot containing no text is displayed with a dotted outline.

**Insertion Point**
A blinking marker consisting of a horizontal line and a vertical line that indicates where text or templates will be inserted next.

**Selection**
The part of the equation that will be affected by any subsequent editing commands is highlighted.

**Status Bar**
The Status Bar contains four areas that tell you your current settings for Style, Size, Zoom, and Color. You can change these settings using menu commands or simply right-click on an area to show a menu for that setting. While moving the mouse in the toolbar or in the menus, the four Status Bar entries are temporarily replaced by a message that describes the item the mouse pointer is over. At other
times, the message tells you what operation MathType has just performed or what it is expecting you to do next.

**MathType Toolbar**

The MathType toolbar contains five separate areas: the Symbol and Template Palettes, the Small Bar, and the Large and Small Tabbed Bars.

**Docking and Floating the MathType Toolbar**

The MathType window picture above shows the toolbar in the docked position. You can also dock the toolbar at the bottom of the MathType window or you can make it float above all the equation windows. To move the toolbar, use the mouse to grab the Handle at the left end, and to drag it wherever you like. Also, you can toggle the toolbar between its docked and floating positions by double-clicking on its handle, any unused part of the toolbar, or its title bar when it’s floating. You can also hide or show the toolbar using the Toolbar command on the View menu.

**Symbol Palettes**

If you press or click on one of these buttons, a palette containing various symbols will appear. If you choose one of the symbols, it will be added to your equation at the insertion point.

**Template Palettes**

If you press or click on one of these buttons, a palette containing various templates will appear. If you choose one of the templates, it will be added to your equation at the insertion point or, if something is selected, it will “wrap” around it.

**The Bars**

The Small Bar and the Large and Small Tabbed Bars are containers in which you can store frequently used symbols, templates, and expressions (whole equations or parts of equations).

**Organizing Tip**

The Tabs allow you to organize your symbols, expressions, and templates, into named collections. Tutorial 5 in Chapter 4 shows you how to rename Tabs.

**Adjusting Toolbar Size and Content**

You will probably not need all of the items described above, so we provide commands on the View menu for showing them or hiding them as you wish. For example, if you have a small screen, you might want to keep some of the bars hidden while you are typing. You can then use one of MathType’s keyboard shortcuts to show the bar you need, and then use the shortcut again to hide the bar when you’re done. See Tutorial 5 in Chapter 4 for more advice on using the toolbar.
Changing the Size of the Toolbar Buttons

You may find MathType’s default size of toolbar icons too small to read. You can change their size using the Workspace Preferences command on the Preferences menu. The picture of the MathType window above shows the small button size. Here are the three available sizes of buttons for comparison:

- **Small**
- **Medium**
- **Large**

**Ruler**

Shows you how large your equation is, and allows you to set tab stops that control formatting.

The MathType window also contains other elements, which we have not labeled since they are common to most Windows applications. Refer to your Windows manual or online Help if any of these items are unfamiliar.

**Keyboard Notation in this Manual**

Your computer’s keyboard has a number of special keys that we will be referring to frequently in this manual. We will write the names of these keys (and combinations of these keys) in small capitals: **CTRL**, **SHIFT**+**A**, **ALT**, **BACKSPACE**, **CTRL**+**TAB**, and so on.

Your carriage return key might be labeled “Return” or “Enter”, and it probably has a ↵ symbol printed on it. We will refer to this key as the **ENTER** key in this manual.

You will also have a set of four arrow keys: the **LEFT ARROW**, **RIGHT ARROW**, **UP ARROW**, and **DOWN ARROW** keys (←, →, ↑, ↓). These keys are grouped together on most keyboards, and you should have no trouble identifying them as the “arrow” keys, although your **TAB**, **BACKSPACE**, and **SHIFT** keys may also have arrows printed on them.

**Entering Text from the Keyboard**

When the MathType window first appears on the screen, a single empty slot is displayed as a small dotted box containing the blinking insertion point. Whenever the insertion point is displayed, MathType is ready to accept text. Typing will cause the corresponding characters to be inserted into the slot containing the insertion point. Pressing the **BACKSPACE** key will erase the character or symbol to the left of the insertion point. Pressing the **ENTER** key will start a new line below the original line. Immediately after typing, you can choose
the Undo Typing command on the Edit menu to erase everything that you typed since the last non-typing operation.

Why the Spacebar Doesn't Work

The SPACE key usually has no effect, since MathType performs spacing of mathematical equations automatically. Professional-quality mathematical formatting involves six different space widths, none of which is the same width as the space character in most fonts, so it would be undesirable to insert the standard space character into your equations. Many people find this a bit confusing at first, but you will get used to it quickly. However, sometimes you might want to insert a non-mathematical phrase into your equations and, here, the standard space is exactly what you want. To do this, just change the current style to Text and start typing. See Tutorial 4 in Chapter 4 for details.

Sometimes you may find it necessary to override MathType’s automatic spacing. There are Ctrl (Control) key shortcuts for entering various widths of space; for instance, Ctrl+Space inserts a thin space. See Tutorial 6 in Chapter 4 for more information.

Inserting Symbols

To insert a symbol, you click on it in one of the bars, or choose it from one of the Symbol Palettes, as shown in the picture below. The Symbol Palettes work like standard Windows menus — just press or click the mouse button to display the palette’s contents, then choose the desired symbol. The symbol will be inserted immediately to the right of the insertion point or, if something is selected, the symbol will replace it.
Inserting Templates

To insert a template, you click on it in one of the bars, or choose it from one of the Template Palettes. The Template Palettes work like standard Windows menus — just press or click the mouse button to display the palette’s contents, then choose the desired template. The template will be inserted immediately to the right of the insertion point or, if something is selected, the template will wrap itself around it.

A template is a formatted collection of symbols and empty slots. You build expressions by inserting templates and then filling in their slots. You can insert templates into the slots of other templates, so complex hierarchical formulas can be built up in a natural way. Slots are “intelligent” in the sense that they control the properties of any characters inserted into them. For example, any text that you insert into the upper limit slot in a summation template is automatically reduced in size and is centered above the summation sign.

Placing the Insertion Point

You can place the insertion point within the text in any slot by positioning the arrow pointer over the desired position, and clicking, just like in a word processor. Pressing the TAB key or the INSERT key will move the insertion point to the end of the next slot in the equation. Therefore, by repeatedly pressing the TAB or INSERT key, you can make the insertion point cycle through every slot in the equation. (Since the TAB key is used to cycle the insertion point, you may be wondering how to enter tab characters. This is done with CTRL+TAB.)

If you hold down the SHIFT key while pressing the TAB key, the insertion point will move around the equation in the reverse direction. You can also move the insertion point by using the arrow keys, this is described in more detail in the following section.

You can tell which slot contains the insertion point from its size and shape. The horizontal line of the insertion point runs along the bottom edge of the slot, and the vertical line of the insertion point runs from the top to the bottom of the slot.
Chapter 3: Basic Concepts

The equations in the first row below show four different insertion point positions, and the four pictures in the second row show the result of typing an \( m \) into the expression in each case:

\[
\begin{align*}
\frac{C}{\mu a_n} & \quad \frac{C}{\mu a_{n1}} \\
\downarrow & \Downarrow \\
\frac{C}{\mu m a_n} & \quad \frac{C}{\mu a_{n2}} \\
\end{align*}
\]

**Moving the Insertion Point**

As described previously, you can use the TAB key to move the insertion point through all of an equation's slots. Holding down the SHIFT key moves the insertion point in the reverse direction. You can also use the arrow keys for moving the insertion point more precisely.

The rules for using the arrow keys are somewhat tedious to describe (and to read, no doubt) — it's easier to experiment with a couple of equations to understand the behavior. Here's a quick guide to how they work.

Roughly speaking, pressing the LEFT ARROW key moves the insertion point one character to the left, and RIGHT ARROW moves one character to the right. If the next character is a template, the insertion point moves into the template's first slot. If there are no more characters in a template slot to move over, the insertion point will move out of the template.

If you hold down the CTRL+SHIFT key combination while pressing the arrow keys, the insertion point will move over templates; it will not move into a template's first slot.

The UP ARROW and DOWN ARROW keys move the insertion point up and down between lines or template slots. The up and down directions are generally determined by the physical location of each slot, but when templates are nested within templates, the template hierarchy may take precedence, and not every slot may be passed through.

The HOME key moves the insertion point to the beginning of the current slot, the END key moves it to the end. The PAGE UP and PAGE DOWN keys scroll the MathType window up and down respectively, but do not actually move the insertion point.
Selecting Items in an Equation

As usual in Windows applications, you have to select the items that you want to operate upon before you choose the command that is to be applied to them. In MathType, the selected part of the equation will be affected by a subsequent editing command such as Cut, Copy, or Nudge. To select part of an equation, you position the mouse pointer over one end of the items to be selected, and then press and hold down the mouse button while dragging the pointer over the equation. The selected items will be highlighted.

Selecting with the Arrow Keys

You can make a selection (or extend a previous selection) by holding down the SHIFT key and pressing the LEFT ARROW or RIGHT ARROW key. Pressing the arrow key moves the insertion point through your equation, in the usual way, and holding down the SHIFT key will cause it to select all the items it passes through.

Selecting Embellishments and Parts of Templates

Holding down the CTRL key allows you to select a character embellishment, such as a “hat” or overbar, or an item that is part of a template (as opposed to an item within one of the slots in a template), such as the $\Sigma$ in the picture below. If you hold down the CTRL key, then the mouse pointer changes from an angled arrow into a vertical one. You can then select the template component by clicking on it with the vertical pointer. This is useful if you want to change the size of a summation sign or nudge a prime to a new position, for example.

\[ y^{\Sigma} \sum_{i=1}^{\infty} a_i \]

The ENTER Key

Pressing the ENTER (\texttt{\textbackslash}) key will create a new line with a single empty slot immediately beneath the slot containing the insertion point. A series of lines created in this way, one above another, is called a pile. You can use piles to represent matrices and column vectors, if you prefer them to MathType’s built-in matrices. Pressing the BACKSPACE key with the insertion point at the beginning of a line will join it back to the line above.
Keyboard Shortcuts

You can execute almost all MathType operations directly from the keyboard by entering keystrokes while holding down the Ctrl (Control) key. For example, you can insert a fraction template using Ctrl+F, i.e. by typing an F while holding down the Ctrl key. Shortcuts of this sort are useful for advanced users, especially expert touch-typists who like to keep their hands on the keyboard.

Some shortcuts require you to type two keystroke combinations consecutively. For example, Ctrl+Shift+I, 2 is a shortcut that inserts a double integral template. To type this, you must first type Ctrl+Shift+I by pressing all three keys at the same time, release them, then type a 2.

In this manual, when a shortcut must be entered with the Shift key held down, the Shift key will always be mentioned explicitly. When there are two characters on the key cap, the more mnemonic character is named. For example, the shortcut for inserting a \{\] template is written as Ctrl+Shift+\, not Ctrl+Shift+\. 

Watch the Status Bar
When the mouse is over a symbol or template in the Toolbar, the Status Bar shows its keyboard shortcut. You can list all shortcuts by using the Customize Keyboard command or by looking in the online help. See Tutorial 14 in Chapter 4 for more information.
Chapter 4
Tutorials

Before You Start

This chapter contains several tutorial examples of using MathType. We provide step-by-step instructions for each example, so you should find it easy to work through them. Each tutorial should take you no more than 10 minutes, and they are by far the best way to learn MathType. Before you start, however, there are a few things to bear in mind.

First, recall that you can find symbols and templates either in the palettes at the very top of the MathType window, or in the bars lower down. You have to pull down the palettes to find the items you need, but you can just click on the ones in the bars. For the most part, the tutorials will require very common symbols and templates that we placed in the bars for you before we shipped MathType. You can change the contents of these bars at any time; we explain how in Tutorial 5.

Also, you do not have to worry about making mistakes. If you type something wrong, or choose the wrong symbol from one of the palettes, you can correct your mistake by pressing the BACKSPACE key.

Fonts and the Appearance of Your Equations

The tutorials will often tell you that “your equation should now look like this.” In fact, the appearance of your equation will be determined by the fonts you are using, so you shouldn’t take this statement too literally. MathType’s default choice of fonts is based on Times New Roman, Symbol and MT Extra. These fonts will probably be acceptable, at least for the purposes of working through the tutorial, and we recommend that you stick with them until you’ve gained some experience working with MathType.

For the time being, please do not change fonts by using the Other command on the Style menu — as you’ll see in Tutorial 8, there’s a much better way of doing this in MathType, and we don’t want you to get into any bad habits.

Some Final Advice

In the first few tutorial examples, we’re going to assume that you’re using MathType along with Microsoft Word to create a document. MathType works with a wide variety of word processing, page layout, and drawing programs, but Word is by far its most common companion. If you want to work through the tutorials using some other word processing application, it should be easy to adapt the instructions that follow. Also, detailed instructions for using MathType with other applications are available in Chapter 5.
In the tutorials, we’ll often tell you to type certain characters into your equations. The characters you have to type will be shown in **bold** type.

**Tutorial 1: Fractions and Square Roots**

In our first tutorial, we will create the equation

\[ y = \sqrt{\frac{x}{n}} \sin x - c^2 \pm \mu \tan x \]

This is a very simple equation, but you’ll learn about fractions and square root templates, and we’ll explore the properties of the insertion point, and illustrate MathType’s function recognition and automatic spacing capabilities.

To create the equation, just follow the steps listed below. Remember that the characters you have to type into the equation are shown in **bold type**.

1. Open a new Word document, and type a few lines of text, just to make the situation a bit more realistic.

2. Now we’re ready to insert a MathType equation. If you installed MathType correctly, there should be a MathType menu towards the right-hand end of the Word menu bar. From this menu, choose Insert Display Equation. This will open a MathType window, ready for you to start creating the equation. If for some reason neither the MathType menu nor the MathType toolbar is available in Word, use Word’s Insert Object command (choose Object on the Insert menu), and choose MathType 4.0 Equation from the list of object types displayed. See Chapter 5 to learn about other ways to insert an equation, either in Word or other applications.

3. In the MathType window, type \( y = \). You don’t have to type a space between the \( y \) and the \( = \), because MathType takes care of the spacing automatically. To help you break the habit of typing spaces, the spacebar is disabled most of the time in MathType, so pressing it will have no effect (other than producing an annoying beep!). Chapter 7 discusses where and how you should enter spaces in MathType, but you won’t have to do this very often.

   Also, notice that the \( y \) has been made italic, but the \( = \) sign has not. Mathematical variables are almost always printed in italics, so this is the default in MathType. You can change this by redefining the Variable style using the Define command on MathType’s Style menu. See Chapter 6 for details.

4. Now we need to enter a square root sign. To do this, click on the \( \sqrt{ } \) icon in the Small Bar. The \( \sqrt{ } \) template’s home is in the \( \frac{b}{c} \) palette, but we’ve also moved it into the Small Bar to make it easier for you to find. Your equation should now look like this:

\[ y = \sqrt{ } \]
The characters in the equation might be larger than you expect, but this is just a result of the viewing scale you’re using. You can use the commands on the View menu to change the viewing scale to anything between 25% and 800%. The blinking insertion point should be in the slot under the square root sign, indicating that whatever you enter next will appear there.

5. Next, we enter a fraction template. To do this, go to the palette and choose the \( \frac{a}{b} \) template — it’s the one on the right in the top row. This template produces reduced-size fractions, sometimes known as “case” fractions in the typesetting world. Case fractions are generally used to save space when the numerator and denominator of the fraction are just plain numbers. Be careful not to choose the \( \frac{a}{b} \) template — this would create a full-size fraction, which would be too big for this situation. Notice how MathType automatically expands the size of the square root sign to accommodate the fraction. Your equation should now look like this:

\[
y' = \sqrt{\frac{3}{16}}
\]

The insertion point should be in the numerator (upper) slot of the fraction template.

6. To enter the numerator of the fraction, just type 3.

7. Now we need to move the insertion point down into the denominator slot of the fraction. You can do this by pressing the Tab key or by clicking inside the denominator slot in your equation.

8. Enter the denominator by typing 16.

9. Next we need to add the \( \sin x \) outside of the square root sign, and to do this we have to get the insertion point into the correct position in the hierarchy of slots that make up the equation. If you repeatedly press the Tab key, you can make the insertion point cycle through all the slots in the formula. If you hold down the Shift key while you do this, the insertion point will cycle through the slots in the reverse direction. Try this out to see how it works. Three of the positions that the insertion point will assume during the course of this cycling are shown below. Use a viewing scale of 400% or 800%, so that you can see what’s happening a little better:

\[
y' = \sqrt{\frac{3}{16}} \quad y'' = \sqrt{\frac{3}{16}} \quad y''' = \sqrt{\frac{3}{16}}
\]

If you use the Show Nesting command on the View menu, you can get an even better picture of the hierarchical arrangement of slots in your equation.
We have to decide which of these insertion point positions is the right one for adding the $\sin x$. The position on the left is clearly wrong — we don’t want the $\sin x$ to go in the denominator of the fraction. In the position shown in the center, the insertion point is in the main slot under the square root sign, so if we type in $\sin x$ the result will be the following formula:

$$y = \sqrt{\frac{3}{16}} \sin x$$

This is not what we want either. The insertion point position shown on the far right is the correct one; the insertion point is outside the square root, which is where we want the $\sin x$ to go.

10. Keep pressing the Tab key until the insertion point arrives in the correct position, and then type in the letters $\sin x$. Type slowly, so that you can watch what happens. When you initially type them, the s and the i will be italic, because MathType assumes that they are variables. However, as soon as you type the n, MathType recognizes that sin is an abbreviation for the sine function. Following standard typesetting rules, MathType uses plain Roman (non-italic) format for the sin, and inserts a thin space (one sixth of an em) between the sin and the x.

11. Type $-c$. Remember you don’t have to type the spaces. You insert the minus sign by pressing the $-$ (minus) key on your keyboard. In a word processor, pressing this key inserts a hyphen, which is typically shorter than a minus sign. However, since hyphens are very uncommon in mathematics, MathType replaces them by minus signs for you (when the Math style is in effect). Your equation should now look like this:

$$y = \sqrt{\frac{3}{16}} \sin x - c$$

12. Next we need to attach the superscript (or exponent) to the $c$. To do this, click on the $^\text{th}$ icon in the Small Bar. This will create a superscript slot next to the $c$, as shown below:

$$y = \sqrt{\frac{3}{16}} \sin x - c^3$$

13. Type 2, and then press Tab to move the insertion point out of the superscript slot, into the position shown below:

$$y = \sqrt{\frac{3}{16}} \sin x - c^2$$
14. Click on the ± in the Small Bar. MathType knows that the ± symbol is supposed to have spaces around it in this situation, so, as usual, you don’t have to type them.

15. Choose the μ from the \( \mu \) palette — it’s the second one from the right in the row of Symbol Palettes. Alternatively, as the Greek letter μ corresponds to the letter m, you can press Ctrl+G, followed by m. Your equation should look like this:

\[
y = \sqrt{\frac{3}{16}} \sin x - c^2 \pm \mu
\]

16. Finish the formula by typing \( \tan x \). Again, notice that MathType uses plain (instead of italic) type for the tan function and puts thin spaces on either side of it. Your finished equation should look like this:

\[
y = \sqrt{\frac{3}{16}} \sin x - c^2 \pm \mu \tan x
\]

17. Close the MathType window, either by clicking on its close box or by choosing the Close and return to <document> command on the File menu, and choose Yes in response to the dialog that asks if you want to save changes. This will insert your equation into the Word document in “displayed” form (on a line by itself), like this:

\[
y = \sqrt{\frac{3}{16}} \sin x - c^2 \pm \mu \tan x
\]

18. In other situations, you might want to embed an equation within a line of text, for example \( y = \sqrt{\frac{3}{16}} \sin x - c^2 \pm \mu \tan x \), rather than displaying it on a line by itself. To do this, use the Insert Inline Equation command from Word’s MathType menu or MathType toolbar.

**Tutorial 2: Sums, Subscripts & Superscripts**

In this tutorial we’ll create the formula that is often used to calculate a statistical quantity known as variance. The formula is:

\[
\sigma_x^2 = \frac{1}{n} \left( \sum_{i=1}^{n} x_i^2 - n \bar{x}^2 \right)
\]

This formula illustrates the use of subscripts, superscripts, and summation templates. Integral and product templates behave much the same as summation templates, so what you learn in this tutorial will be useful in a variety of other situations. The steps required to create the formula are as follows:

1. Open a new Word document, and type a few lines of text.
MathType User Manual

2. Choose the Insert Display Equation command from Word’s MathType menu or MathType toolbar. This will open a MathType window, ready for you to start creating the equation.

3. Enter a $\sigma$. One way to do this is to choose it from the $\sigma$ palette. Alternatively, you could use its keyboard shortcut. The keyboard shortcuts for toolbar items are displayed in the status bar as you move the mouse over them. In this case you can press $\text{CTRL}+G$ followed by $s$.

4. Next, create slots for the subscript and superscript on the $\sigma$ by clicking on the icon in the Small Bar. Subscripts and superscripts are rather small. In order to better see what’s happening, make sure you’ve chosen at least 200% viewing scale in the Zoom submenu of the View menu.

5. The insertion point will be located in the newly created subscript slot. Type the subscript, $X$.

6. Move the insertion point up into the superscript slot either by clicking in it or by pressing the $\text{TAB}$ key. Then type the number 2 into the superscript slot.

7. Now let’s move the insertion point to the location shown below:

$$\frac{\sigma^2}{\bar{X}}$$

Either press the $\text{TAB}$ key, or click somewhere out to the right of the equation, as shown in the picture. Be careful not to place the pointer too close to the subscript or superscript slots, or else the insertion point may jump into one of them when you click.

8. Type in the $=$ sign. Remember not to type any spaces.

9. Construct the fraction by using the $\frac{\text{template}}{\text{template}}$ template, which is available in the Small Bar and in the $\frac{\text{template}}{\text{template}}$ palette. Be careful — it’s not the same template as the $\frac{\text{template}}{\text{template}}$ fraction template that we used in Tutorial 1.

10. The insertion point will be located in the newly created numerator slot; type the number 1 into this slot.

11. Move the insertion point down into the denominator slot either by clicking in it or by pressing the $\text{TAB}$ key. Then type in the denominator, $n$, and press the $\text{TAB}$ key again to move the insertion point out of the denominator slot. Your equation should now look like this:

$$\frac{\sigma^2}{\bar{X}} = \frac{1}{n}$$

12. Next we need to insert a pair of braces (curly brackets). You can do this either by clicking on the $\{\}$ icon in the palette, or by using the $\text{CTRL}+\text{SHIFT}+[$

---

**Zoom Levels**
A quick way to change zoom level is to right-click in the Zoom panel on the status bar. Or, you can type:
- $\text{CTRL}+1$ for 100%,
- $\text{CTRL}+2$ for 200%,
- $\text{CTRL}+4$ for 400%, or
- $\text{CTRL}+8$ for 800%.

**Inserting Fractions**
You can also insert the fraction template by pressing $\text{ALT}+F$. 

---

24
keyboard shortcut (hold down the CTRL and SHIFT keys while pressing the key that bears the [ and ] characters).

13. Click on the $\sum$ icon to enter a summation template inside the braces. Notice how the braces expand automatically. Your equation should now look like this:

$$\sigma^2_X = \frac{1}{n} \left\{ \sum \right\}$$

14. Type the letter $X$ into the summand slot (the large slot on the right).

15. Attach a subscript and superscript to the $X$, using the $\mathbb{L}_i\mathbb{L}^2$ template. Fill in the subscript and superscript slots with $i$ and $2$, respectively.

16. Move the insertion point into the lower limit slot of the summation template by clicking inside the slot, and type $i=1$. As usual, do not type any spaces. MathType will automatically reduce the size of the text, and will center it below the summation sign. In this case, MathType will not insert any spaces around the $=\text{ sign}$, since it is in the limit of a summation. Again, this is a standard typesetting convention that you can override if you want to.

17. Click in the upper limit slot of the summation template, and type in the upper limit, $n$.

18. Move the insertion point into the position shown below:

$$\sigma^2_X = \frac{1}{n} \left\{ \sum_{i=1}^{n} X^2 \right\}$$

If the insertion point is in the upper limit slot of the summation template, pressing the TAB key will do the trick. In fact, as we saw in Tutorial 1, if you keep pressing the TAB key, the insertion point will cycle through all the slots in the equation and will eventually reach the position shown, regardless of where it started out. If you want to move the insertion point by clicking, click somewhere near the point indicated by the arrow in the picture above. You might want to use the Show Nesting command on the View menu to make this easier.

19. Type $-nX$.

20. Place a bar over the $X$ by clicking on the $\mathbb{L}$ icon in the $\mathbb{L}\mathbb{L}$ palette. In MathType, embellishments of this type are always added to the character to the left of the insertion point. You can even add several embellishments to the same character. For more details, look for Embellishments in MathType’s online Help.
21. Enter the superscript 2 by using the \( \textsuperscript{2} \) template. It works just the same way as the \( \textsuperscript{3} \) template that we used earlier. The equation is now complete (well, maybe it is — see the next step below).

22. We hope you’re happy with the way MathType formats your equation, but, if you’re not, we’ve provided a way for you to make some fine adjustments of your own. You can select any item or group of items, in the usual way, and nudge them either horizontally or vertically in steps of one pixel (screen dot). If you view your equation at 800% scale you can make adjustments as small as an eighth of a point.

To nudge items, use the following keystrokes:

- \( \text{CTRL} + \text{	extless} \) nudge the selected items to the left by one pixel
- \( \text{CTRL} + \text{	extuparrow} \) nudge the selected items upward by one pixel
- \( \text{CTRL} + \text{	extgreater} \) nudge the selected items to the right by one pixel
- \( \text{CTRL} + \text{	extdownarrow} \) nudge the selected items downward by one pixel

You might want to try moving a subscript or a superscript, moving the limits of the summation, or even moving the bar embellishment.

Keep in mind, however, that nudging is really intended for making small adjustments that cannot be achieved otherwise. The preferred method for adjusting spacing is using the Define Spacing dialog, described in Chapter 6. This approach has the advantage that the spacing rules you define affect all equations.

23. Close the MathType window, which will insert the equation into your Word document. Save the document, because we’re going to use it in the next tutorial.

**Tutorial 3: Editing Old Equations**

This tutorial teaches you some special editing techniques that are useful when you’re modifying an existing equation. You will often need to correct a mistake in an old equation, or make a new one that is a slight variation of one that you have made in the past. Instead of starting from scratch, you can bring a copy of the old equation back into MathType and modify it as needed. In this way, all your old documents serve as sources of material for new documents. You can store commonly used equations (or fragments of equations) in word processing documents or as expressions within MathType itself.

Let’s suppose that the equation we created in Tutorial 2 is the wrong one, and we want to use the following related formula in our document instead:

\[
S_x = \sqrt{\frac{1}{n-1} \left( \sum_{i=1}^{n} X_i - n \bar{X} \right)}
\]
The steps required are as follows:

1. Open the Word document containing the equation you created in Tutorial 2 above. We want to bring this equation back into MathType for editing. There are several ways to do this, as explained in Chapter 5, but the simplest is to double-click on it. This will open the equation for editing, in a new MathType window.

2. Select the term on the left-hand side of the equation by dragging the arrow pointer across it while holding down the mouse button. The selected items will be highlighted by black-white reversal, in the usual Windows manner. It should look like this:

\[ \sigma^2_X = \frac{1}{n} \left\{ \sum_{i=1}^{n} X_i^2 - n\bar{X}^2 \right\} \]

3. Delete the selected items by using the Clear command on the Edit menu, or by pressing the BACKSPACE key.

4. The insertion point is in the right place, immediately to the left of the = sign, so you can now enter the new left-hand side. Type in the letter \( s \) and attach the \( X \) subscript to it by using the template, in the usual way.

5. Next, we're going to enclose the right-hand side in a square root sign. We're going to “wrap” a \( \sqrt{\ } \) template around the existing terms — previously we have always inserted templates first, and then filled in their slots afterwards. Select the entire right-hand side of the equation, watching the highlighting carefully to see that your selection is correct. It should look like this:

\[ S_X = \frac{1}{n} \left\{ \sum_{i=1}^{n} X_i^2 - n\bar{X}^2 \right\} \]

Now click on the \( \sqrt{\ } \) icon in the Small Bar. The \( \sqrt{\ } \) template will be inserted into your equation and automatically wrapped around the selected items. When you insert a template, MathType always wraps it around any selected items.

6. You might be wondering how you would do the reverse of the operation we performed in step 5 — suppose you had an expression enclosed in a square root sign (or some other template) and you wanted to remove the square root sign but keep the expression. To do this, you first select the expression under the square root sign and choose Cut to transfer it to the Clipboard. Next, select the (now empty) square root sign, and press BACKSPACE to remove it. Finally, choose Paste to bring the expression back from the Clipboard.
7. Finally, we have to change the $n$ in the denominator of the fraction to $n - 1$. Position the insertion point in the denominator slot, to the right of the $n$, by clicking near the point indicated by the arrow pointer in the picture below: 

$$S_X = \sqrt{\frac{1}{n} \left\{ \sum_{i=1}^{n} X_i^2 - n \bar{X}^2 \right\}}$$

Then, simply type $-1$ to change the denominator.

8. Let’s now suppose we want to change the color of the term $s_x$ from black to red. Select the term using the mouse, and then choose the Color command on the Format menu. A submenu appears containing a list of colors. Choose Red and release the mouse. The selected term will become red (you will have to click outside the equation to de-select the term in order to see the new color).

9. We’re finished editing the equation, so close the MathType window. If a dialog appears asking if you want to save your changes, click Yes. Once the MathType window has closed, your word processor will become active and you’ll see that your document now contains the modified equation.

**Tutorial 4: Including Text in an Equation**

In our next tutorial, we show you how to enter words and phrases in an equation, and also how to handle function name abbreviations that MathType does not recognize. We are going to create the following equation:

$$\text{Pr}(A \mid B) = \frac{\text{Pr}(A \cap B)}{\text{Pr}(B)} = \frac{\text{Probability that both } A \text{ and } B \text{ occur}}{\text{Probability that } B \text{ occurs}}$$

1. First, open a new MathType window using one of the methods you’ve already learned. Then type $\text{Prob}(A \mid B)$. The result will be $\text{Pr}(A \mid B)$.

Using its built-in table of function names, MathType has recognized Pr as an abbreviation for “probability” and set it in the Function style, while o and b are regarded as variables. In this tutorial, we want to use Prob, rather than just Pr, as our abbreviation for “probability”. You might think that you can fix the problem by just making the o and b non-italic, but we don’t recommend this. If you simply remove the italicization, MathType will still regard o and b as variables, which is not what we intend. The right approach is to select Prob and choose Function from the Style menu. This will remove the italics, but it also tells...
MathType that Prob is the name of a function, which will affect spacing and translation into languages such as \LaTeX and MathML.

3. Create the fraction in the middle term of the equation. You can copy Prob(A | B), and modify it for re-use in the numerator and denominator. You can find \(\cap\), the set intersection symbol, on the palette. Your equation should now look like

\[
\text{Prob}(A | B) = \frac{\text{Prob}(A \cap B)}{\text{Prob}(B)} =
\]

4. Construct the fraction on the right-hand side of the equation by using the template again, and place the insertion point in the numerator, ready to type the text.

5. If you just start typing characters into the numerator slot, MathType will assume that they are variables, so they will be italicized, and any spaces you type will be ignored. To type ordinary words and phrases, you should first choose Text from the Style menu. Then type \textit{Probability that both A and B occur}. The numerator of our fraction will look like this:

This is what we want, except that the word “both” should be bold and the A and B should be italic.

6. Select the word “both”, and choose Other from the Style menu. The Other Style dialog will appear, which lets you directly change the font and style (bold & italic) of selected characters. Click on Bold, and then choose OK.

7. Next we want to make the variables A and B italic. We could do this directly by using Other from the Style menu again, but this would not really convey the correct meaning. A better approach is to select the variable A and choose Math from the Style menu, and then repeat for the variable B. This makes the A and B italic, but also tells MathType to treat them as mathematical variables.

8. Enter the denominator of the fraction using the same technique we used for the numerator.

This completes the equation, but we can use it to illustrate a few more of MathType’s capabilities.

If you use the abbreviation “Prob” for probability on a regular basis, you’ll get tired of manually changing it to Function style all the time, and you’ll want MathType to do this for you automatically. From the Preferences menu, choose Functions Recognized. Type \textit{Prob} as the name of a new function, and click on the Add button. Also, if you don’t want MathType to recognize Pr as an abbreviation.
for "probability", you can select Pr in the list of recognized functions and click on the Remove button.

Now try recreating this same equation, to see how much easier it is.

**Tutorial 5: Using MathType’s Toolbar**

In the previous tutorials we saw two formulas that were very similar, in the sense that they had many terms in common. This is typical of many branches of mathematics. For example, consider these formulas from elementary statistics:

\[
\sigma^2 = \frac{1}{k} \left( \sum X_i^2 - k \mu^2 \right) = \frac{1}{k} \left( \sum X_i^2 - \frac{1}{k} \left( \sum X_i \right)^2 \right)
\]

\[
r = \frac{\sigma_{xy}}{\sigma_x \sigma_y} = \frac{\sum X_i Y_i - \frac{1}{k} \left( \sum X_i \right) \left( \sum Y_i \right)}{\sqrt{\left( \sum X_i^2 - \frac{1}{k} \left( \sum X_i \right)^2 \right) \left( \sum Y_i^2 - \frac{1}{k} \left( \sum Y_i \right)^2 \right)}}
\]

Many statistical formulae use the symbols \( \mu \) and \( \sigma \), and they often involve various combinations of terms like \( \sum X_i, \sum X_i^2, \frac{1}{k} \). When dealing with repetitive formulae like these you can save yourself a great deal of time by customizing MathType. To save time creating statistical formulae, we’re going to place \( \sigma \) in the Small Bar. We’ll also make expressions for \( \sum X_i \) and \( \frac{1}{k} \), and place them in the tabbed bars. Then we’ll use them to create the second of the equations shown above. The steps are as follows:

1. Before we start, make sure that MathType’s toolbar is visible and that the Small Bar and the Small and Large Tabbed Bars are visible. Use the commands in the View menu to make them visible if necessary.

2. Click on the [\( \lambda \omega \beta \)] symbol palette, and then release the mouse button. The palette will appear.

3. Now hold down the ALT key, press on the \( \sigma \) and, keeping the mouse button down, drag it over the Small Bar. You’ll see the mouse pointer change shape as it passes over different areas of the toolbar. When the pointer looks like this [\( \mathbb{Q} \)], the dragged item cannot be dropped at this location and releasing the mouse button will have no effect. When the pointer looks like this [\( \mathbb{B} \)], it is over a valid target area and releasing the mouse button will insert the object at this location. Release the mouse button over the Small Bar, as shown below.
The symbol will be added to the end of the bar. Now, to insert this symbol into an equation you only need click on it in the Small Bar instead of hunting for it in the palettes. The Small Bar is a good location for frequently used symbols as it is always available and can contain many items.

4. Next, we’re going to add a $\sum x_i$ expression to the Large Tabbed Bar. The tabbed bars are similar to the Small Bar in how they operate, however they’re divided into categories, which allows for a much larger number of items. Click on the Statistics tab to display MathType’s default items for statistical equations. There should be room for one more item in the Large Tabbed Bar (the bar has room for 8 items). If there isn’t, select another tab that does have room.

5. Delete the current contents of the MathType window, and create the expression $\sum x_i$ in the usual way. You’ll need to use the $\sum$ template (not the $\Sigma$ template) to do this.

7. To add this expression to the toolbar, select it and drag it to the Large Tabbed Bar. When you release the mouse you’ll see the expression appear in the bar.

8. Create an expression for $\frac{1}{x}$, in exactly the same way. Place this expression in the Small Tabbed Bar. You can make the fraction full size, using the $\frac{}{}$ template, or you can make a case fraction using the $\frac{}{=} case$ template. When you’re done, we’re ready to create the formula

$$r = \frac{\sigma_{xy}}{\sigma_x \sigma_y} = \frac{\sum x_i y_i - \frac{1}{k} \left( \sum x_i \right) \left( \sum y_i \right)}{\sqrt{\left( \sum x_i^2 - \frac{1}{k} \left( \sum x_i \right)^2 \right) \left( \sum y_i^2 - \frac{1}{k} \left( \sum y_i \right)^2 \right)}}$$
Creating this formula doesn’t require any new techniques that you don’t already know, so we’re not going to give you the usual step-by-step instructions. Here are a few useful hints and reminders:

- You can insert $\sigma$ by clicking on it in the Small Bar, which is much faster than using the $\sum\omega\theta$ palette.
- You can insert the term $\sum y_i$ by clicking on it in the Large Tabbed Bar.
- A fast way to create $\sum y_i$ is to insert $\sum x_i$, drag across the $X$ to select it, and type $Y$ to replace it.
- You can create $\sum x_i^2$ by inserting $\sum x_i$ and replacing the subscript template with a sub/superscript template. To do this, select the subscript slot as shown below, and hold down the Ctrl key as you insert the $\sum$ template. The Ctrl key causes the new template to replace the selected one instead of wrapping around it. Then type $2$ in the superscript slot.

\[ \sum x_i \]

- Note that the two terms inside curly brackets on the bottom line of the formula are identical except that one involves $X$ and the other involves $Y$. To create the second term, just duplicate the first one and replace the $X$’s with $Y$’s.
- You can duplicate a term by selecting it, holding down the Ctrl key and dragging it to the desired location (without the Ctrl key the term is moved).

Rearranging the Toolbar
MathType’s toolbar is initially filled with expressions useful for many of the various fields in mathematics. You can, however, create your own tabs, rename or delete the existing tabs, as well as rearrange or remove any of the symbols or expressions that are in the default toolbar. You can also modify any of the expressions if they’re not quite right for your particular use.

To move a symbol or expression within the toolbar, hold down the Alt key and drag the item to its new location. You can insert an item between two others by dropping it between them.

Try this by dragging the $\sigma$ symbol we added to the Small Bar in Step 3 to the Small Tabbed Bar. The choice of where to place an item is entirely up to you; a symbol or expression can be placed in any of the bars.

Now let’s delete the $\sigma$ from the Small Tabbed Bar.
11. Right-click on the $\sigma$ and select Delete from the context menu that appears. You may also want to delete the other expressions you added to the tabbed bars. You can also change the names of the tabs to suit your particular situation.

12. Double-click on the Statistics tab to open the Tab Properties dialog, where you can edit the tab’s name and change its keyboard shortcut. If you prefer typing to using the mouse, you may want to use the toolbar’s keyboard interface. You can give the keyboard focus to a toolbar component using the following keyboard commands:

- Symbol Palette: F5
- Template Palette: F6
- Small Bar: F7
- Large Tabbed Bar: F8
- Small Tabbed Bar: F9

Once a bar has the focus, you can use the left and right arrows to move the selection, and ENTER to insert the selected item (or open its corresponding menu). The Esc key closes a menu, or returns the focus to the equation area. You can switch tabs by typing CTRL+F10, n where n is the number of the tab to activate. For example, typing CTRL+F10, 2 activates the second tab.

**Deciding What to Place in the Toolbar**

Some symbols and templates are used so frequently that you may not need to place them in the toolbar. You probably will have memorized the keyboard shortcuts for inserting them, so there’s not much to be gained by having them occupy valuable space in the toolbar. Greek symbols in particular fall into this category; once you’ve learned that you can insert a $\beta$ by pressing CTRL+G followed by $b$ (referred to as CTRL+G,B), you probably won’t need to add these characters to the toolbar.

It may make sense, however, to add characters from any special fonts you may have to the toolbar. The easiest method is to use the Insert Symbol dialog (choose the Insert Symbol command on the Edit menu), which is an extremely powerful tool for viewing the characters in a font. You can also ALT-drag characters from this dialog to the toolbar. You can add as many characters from your fonts to the toolbar as you wish. Then you can enter these characters at any time into your equations, regardless of your current style definitions.

That does it for Tutorial 5, so choose Select All (CTRL+A) from the Edit menu and press BACKSPACE to clear the window for the next tutorial.
Tutorial 6: Spacing and Alignment

In our next example we introduce some of MathType’s facilities for controlling spacing and alignment in equations. We are going to create the following pair of equations:

\[
\int_0^1 a(x) \, dx \leq \limsup_{\alpha \to \infty} \phi_{\alpha}(a) \\
\int_0^1 a(x) b(x) \, dx \leq \limsup_{\alpha \to \infty} \psi_{\alpha}(a, b)
\]

Note that these equations are arranged so that their \( \leq \) signs are vertically aligned, and they both contain a “lim sup” construction of a type that we have not used before. You can create these equations as follows:

1. Insert a definite integral template by clicking on the \( \int \) icon or by pressing \( \text{CTRL}+I \), type in the integrand (the large slot), and fill in the 0 and 1 as the limits of integration (the two small slots). You probably won’t want the parentheses in the integrand to be of the “expanding” variety, so you can just type them from the keyboard, rather than using the \( (\int) \) template. Your equation should now look like this:

\[
\int_0^1 a(x) \, dx
\]

2. To improve the appearance of our equation, we should insert a thin space (one sixth of an em) in between the \( a(x) \) and the \( dx \) in the integrand. MathType can not do this automatically, so we provide you with a convenient way of manually entering a space of the correct size. The \( \{a\ b\} \) palette provides a set of five icons representing commonly used spaces, as shown in the following table.

<table>
<thead>
<tr>
<th>Icon Set</th>
<th>Keystroke</th>
<th>Alt. Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( a b )</td>
<td>\text{SHIFT+SPACE}</td>
<td>\text{CTRL+K,0}</td>
<td>Zero space</td>
</tr>
<tr>
<td>( a b )</td>
<td>\text{CTRL+ALT+SPACE}</td>
<td>\text{CTRL+K,1}</td>
<td>One point space</td>
</tr>
<tr>
<td>( a b )</td>
<td>\text{CTRL+SPACE}</td>
<td>\text{CTRL+K,2}</td>
<td>Thin space (sixth of an em)</td>
</tr>
<tr>
<td>( a b )</td>
<td>\text{CTRL+SHIFT+SPACE}</td>
<td>\text{CTRL+K,3}</td>
<td>Thick space (third of an em)</td>
</tr>
<tr>
<td>( a b )</td>
<td>None</td>
<td>\text{CTRL+K,4}</td>
<td>Em space (quad)</td>
</tr>
</tbody>
</table>

Place the insertion point between the “)” and the “d” by clicking there, and insert a thin space either by choosing the \( a b \) icon (it’s on the right in the top row of the \( \{a\ b\} \) palette) or by pressing \( \text{CTRL+SPACEBAR} \).
3. Move the insertion point out of the integrand slot, into the position shown below. You must do this for the alignment commands to work properly. Don’t create the rest of the equation within the integrand slot.

\[ \int_{0}^{1} a(x) \, dx \]

4. Click on the ≤ sign in the Small Bar.

5. Now we want to build the “lim sup” structure. We begin by clicking on the \( \text{\textcopyright} \) icon in the Template Bar. This icon represents an underscript template: any characters entered in the upper slot will be full size, and those in the lower slot will be reduced to “subscript” size.

6. The insertion point is positioned in the upper slot, so you can type in \( \text{limsup} \). MathType will use your “Function” style (probably a plain style) for these characters, and will insert a thin space between the “lim” and the “sup”.

7. Move the insertion point down into the lower slot by clicking in it or by pressing the TAB key, and enter \( n \to \infty \). The \( \to \) and \( \infty \) symbols are very common in mathematics, so they’ve been added to MathType’s default Small Bar. They’re also available in the Symbol Palettes, of course. Following typesetting conventions (as always), MathType will not create any spacing around the \( \to \) symbol, since it is in a “subscript,” but you can insert spaces, if you want to.

8. Press TAB to move the insertion point out of the lower slot, and type in the rest of this first equation. The speedy way to do this is to just type \( \text{CTRL}+G \ f \ \text{CTRL}+L \ n \ \text{TAB} \ ( \ a \) ). If you like the \( \text{CTRL}+G \) shortcut, you may be interested to know that there are a few others that work in a similar fashion. If you press \( \text{CTRL}+U \), for example, the next character you type will be assigned the User 1 style that you have defined with the Define command on the Style menu. In this way, you can access any character in any font with just two keystrokes, even if it’s not present in the Symbol Palettes.

9. Press the ENTER key. This will create a new line directly beneath the first equation, so now you have a “pile” consisting of two lines. It should look like this:

\[ \int_{0}^{1} a(x) \, dx \leq \limsup_{n \to \infty} \phi_n(a) \]
To save time, we’re going to create the second equation by modifying a copy of the first one. Select the entire first equation by double-clicking somewhere near its $\leq$ sign, copy it to the clipboard, and then paste it into the new empty slot. You should now have two identical copies of the first equation, one directly beneath the other. Now just edit the lower copy to produce the second equation. To change the $\phi$ to a $\psi$, just select the $\phi$ and press CTRL+G followed by $\psi$.

Finally, we’re going to experiment with some different ways of aligning the two equations. You can center or right-justify them by using the Align Center and Align Right commands on the Format menu. Give this a try, just to see how it looks.

In fact, you will probably want to align these two equations so that their $\leq$ signs are directly above one another. To do this, we choose the Align at $=$ command from the Format menu. It will work even though we have $\leq$ signs rather than $=$ signs. You can align the equations in other ways by using alignment symbols. You simply insert an alignment symbol in each equation at the two points that you’d like to have aligned. (However, note that alignment symbols inserted into template slots will not work.) Placing an alignment symbol to the right of each of the two $\leq$ signs would give the same results as using the Align at $=$ command, for instance. The alignment symbol is represented by the $\equiv$ icon in the Symbol Palettes — it’s located in the palette.

You may also want to adjust the line spacing, or leading, i.e. the amount of vertical space between the two equations. You can do this by placing the insertion point somewhere in the outermost slot of the second equation (not within a template), or by selecting the second equation, and choosing the Line Spacing command from the Format menu. When you’ve arranged them to your liking, the equations are complete.

Now that we’re done with these equations, it’s time to choose Select All from the Edit menu and press BACKSPACE to clear your window for the next tutorial.

**Tutorial 7: A Simple Matrix**

In our next tutorial, we illustrate MathType’s powerful capabilities for laying out matrices. We will construct the following matrix equation:

$$p(\lambda) = \det(\lambda I - A) = \begin{vmatrix} \lambda - a_{11} & -a_{12} \\ -a_{21} & \lambda - a_{22} \end{vmatrix}$$

The matrix is a fairly simple one, and we’ll be able to create it very easily by using a matrix template. If you need more flexible formatting capabilities for matrices and tabular layouts, you should use tabs, as illustrated in Tutorial 11.

Type the first few terms of the equation, up to the second equals sign. MathType will recognize that “det” is an abbreviation for the determinant.
function, and will automatically set it in plain roman type, so you don’t have to fiddle with it. The quick way to get a $\lambda$ is to press $\text{CTRL}+G$ followed by a letter I (ell). Also, note that the I and the A represent matrices, so we have assigned them the Vector-Matrix style, which causes them to appear in bold type. The $\text{CTRL}+B$ shortcut will assign the Vector-Matrix style to the next character, so you can press $\text{CTRL}+B$ followed by $\text{SHIFT}+I$ to get the I, and $\text{CTRL}+B$ followed by $\text{SHIFT}+A$ for the A. Alternatively, you can just type all the characters first, and then select them and change their styles using the commands on the Style menu. Either way, your equation should end up looking like this:

$$p(\lambda) = \det(\lambda I - A)$$

2. Type the second $=$ sign and insert a vertical bar template by choosing the $| |$ icon. It’s located in the $[| |]$ palette.

3. Insert a 2x2 matrix template inside the vertical bars by choosing the $\begin{array}{cc} & \\ & \end{array}$ icon from the $[\begin{array}{cc} & \\ & \end{array}]$ palette. Your equation should now look like this:

$$p(\lambda) = \det(\lambda I - A) = \begin{array}{cc} & \\ & \end{array}$$

4. The insertion point will be in the top left slot of the 2x2 matrix, so enter the expression $\lambda - a_{11}$ there.

5. We’re feeling lazy, so we’re going to create the other entries in the matrix by cutting and pasting. Select the $\lambda - a_{11}$ by double-clicking on it, copy it to the Clipboard, and paste it into the other three slots in the matrix. The result should be as shown below; it’s not right, of course, but we’re going to fix it up in a few moments.

$$p(\lambda) = \det(\lambda I - A) = \begin{vmatrix} \lambda - a_{11} & \lambda - a_{11} \\ \lambda - a_{11} & \lambda - a_{11} \end{vmatrix}$$
6. Next, we’re going to put a little extra space between the vertical bars and the elements of the matrix. This is purely a matter of taste, so you can skip this part if you’d prefer to keep your matrix looking the way it does at present. Before we enter the spaces, we need to position the insertion point so that it’s inside the vertical bars but to the left of and outside the matrix. You can do this by clicking somewhere near the position indicated by the arrow pointer in the preceding picture. Then just enter one or two thin spaces by pressing CTRL+SPACEBAR. Do the same on the right-hand side of the matrix. If you choose the Show All command from the View menu, you’ll be able to see your spaces. They should look like this:

\[
p(\lambda) = \det(\lambda I - A) = \begin{vmatrix}
\lambda - a_{11} & \lambda - a_{11} \\
\lambda - a_{11} & \lambda - a_{11}
\end{vmatrix}
\]

7. After the brief digression in Step 6, it’s now time to correct the entries in our matrix. First, delete the \( \lambda \) from the upper right slot. The quickest way to do this is to place the insertion point to the right of it and press BACKSPACE (or Backspace). Do the same with the \( \lambda \) in the lower left slot. Notice that MathType adjusts the spacing after the minus signs to reflect the fact that they are now unary operators rather than binary operators (negation rather than subtraction).

8. Change all the subscripts in the matrix to their desired values. The “11” in the upper left slot is correct already, but we should have “12” in the upper right slot, “21” in the lower left, and “22” in the lower right. You can double-click on the existing subscripts to select them, and then type the correct values over them, just as you would in a word processor. Your equation should now look like this:

\[
p(\lambda) = \det(\lambda I - A) = \begin{vmatrix}
\lambda - a_{11} & -a_{12} \\
-a_{21} & \lambda - a_{22}
\end{vmatrix}
\]

9. The equation is now essentially complete, although there are a few more formatting options that you may want to try out. First, you might want to shift the entire matrix down so that its top row is aligned with the rest of the equation. To do this, place the insertion point anywhere in the matrix and choose Align at Top from the Format menu. Also, it might be nice to right justify the entries in each column. To do this, place the insertion point somewhere in the matrix, choose the Change Matrix command from the Format menu, and click on the button labeled “Right” in the dialog box.

Finally, if you object to the fact that MathType tightened the spacing after the unary minus signs, you can put the spaces back in again, though this would mean deviating from standard typesetting conventions. They should be thick spaces (one third of an em). The thick space is the middle one in the second row
of the palette. If you prefer to use the keyboard, you can insert a thick space by pressing CTRL+SHIFT+SPACE. Alternatively, since a thick space is the same width as two thin spaces, you can get the same results by pressing CTRL+SPACE twice.

If you elected to make all of the modifications suggested in this step, your equation should look something like the picture below.

\[ p(\lambda) = \det(\lambda I - A) = \begin{vmatrix} \lambda - a_{11} & - a_{12} \\ - a_{21} & \lambda - a_{22} \end{vmatrix} \]

If you’re going on to the next tutorial, press CTRL+A to select all, then press BACKSPACE to clear your screen.

Tutorial 8: Fonts and Styles

This tutorial provides an introduction to MathType’s system of styles. We will demonstrate how to change the fonts in your equations by changing style definitions. Using styles will allow you to achieve the formatting you want quickly and easily, and enable you to create equations with a consistent appearance. See Chapter 6 for more information about styles, fonts and sizes.

In the following steps, we will create the equation

\[ u = \phi \cdot \exp\left\{ \frac{1}{2} \sigma (x + y) \right\} \]

and experiment with changing the look of the equation by using different style definitions.

1. Check that the Status Bar’s Style panel displays “Math”. If it doesn’t, choose Math from the Style menu. If the Math style is not chosen, MathType’s automatic style assignment will not be in effect, and the rest of this tutorial will not make much sense.

2. Create the equation, using the \( \frac{a}{b} \) template for the fraction and inserting the \( \phi \) and \( \sigma \) by choosing them from the lowercase Greek palette, or by using the CTRL+G shortcut. The “.” operator is located on the \( \alpha \cdot \) palette. The equation should now look like this:

\[ u = \phi \cdot \exp\left\{ \frac{1}{2} \sigma (x + y) \right\} \]

3. From the Style menu, choose Define. If necessary, click on the Simple button to display the dialog shown below.
Change the "Primary font" to Euclid, change the "Greek and math fonts" to Euclid Symbol and Euclid Extra, as shown in the dialog above, and then click Apply. On screen, your equation will now look like this:

\[ u = \phi \cdot \exp \left\{ \frac{1}{2} \sigma (x + y) \right\} \]

and if printed will look like this:

\[ u = \phi \cdot \exp \left\{ \frac{1}{2} \sigma (x + y) \right\} \]

The Euclid fonts supplied with MathType are based on the Computer Modern fonts typically used with \TeX, so they give your documents a \TeX-like appearance that you might prefer for some types of work. Another benefit of the Euclid fonts is that their regular and Greek characters have a consistent size, whereas Times and Symbol are somewhat mismatched. Of course, if you use the Euclid fonts in your equations, you will probably want to use Euclid as the primary body font in your word processing document, too.

3. Open the Define Styles dialog, and click on “Factory settings” to return to using the Times and Symbol fonts.

4. Click on the Advanced button to display a more extensive form of the Define Styles dialog, as shown below:
The names of the eleven styles are listed in the dialog box, together with the font and character style assigned to each. The equation you have just created uses the Function, Variable, L.C. Greek, Number, and Symbol styles. The letters “exp” are recognized as the abbreviation for the exponential function, and are assigned the Function style; $u$, $x$, and $y$ are treated as variables and assigned the Variable style; $\phi$ and $\sigma$, being lowercase Greek letters, are assigned the L.C. (lowercase) Greek style, and the numbers in the fraction use the Number style. The symbols $=$, $\times$, $($, $)$, and $+$ use the Symbol style. (The brackets and fraction bar are internal to MathType and do not use a style.) These styles are applied automatically as you create the equation, because you are using the Math style mode. This automatic style assignment is the advantage you gain by using the Math style mode when creating equations.

We’re going to change some of the styles so you understand how they affect an equation’s appearance. Normally you wouldn’t work this way, you’d change fonts using the Simple version of this dialog.

4. Choose a new font for the Function style. The style is probably defined as Times or Times New Roman. Press on the arrow next to the font name in the Function row and choose a different font. You will want to choose a font that looks noticeably different from Times, so that the effect of the change will be obvious. A good choice would be a sans serif font such as Arial.
5. Choose the OK button. Your equation will be redisplayed using the new Function style definition. Your equation should now look like this:

\[ u = \phi \cdot \exp \left\{ \frac{1}{2} \sigma (x + y) \right\} \]

The function abbreviation, exp, is displayed using the new font. Of course, you probably wouldn’t want your equation to look like this — we’re simply demonstrating the effect of changing the Function style definition.

The Variable style definition is used for all ordinary alphabetic characters except for the ones in function abbreviations. In the current equation, this includes \( u, x, \) and \( y. \) Very often, according to convention, the only difference you want between the Variable and Function styles is for the Variable style to be defined as italic. Let’s redefine the Variable style so that it’s consistent with the new Function style definition.

6. Again, choose Define from the Style menu. In the Define Styles dialog box, press on the arrow next to font name in the Variable row, and choose the same font assigned to the Function style. Check that the italic character style is checked for Variable, but not for Function.

Let’s also change the Number style so that it uses the same font as Function and Variable. You will find that this makes the equation look better. Finally, turn off the italic character style for the L.C. Greek style by removing the check in the Character Style column. Lowercase Greek letters are usually italicized, but let’s experiment with this. Note that for the two Greek styles and the Symbol style, you must always assign the Symbol font, the Euclid Symbol font, or some other similar font.

7. Choose the OK button. Your equation will be redisplayed using the new style definitions. If you are using the fonts we’ve recommended, the equation should now look like this:

\[ u = \phi \cdot \exp \left\{ \frac{1}{2} \sigma (x + y) \right\} \]

The “variables” \( u, \) \( x, \) and \( y, \) and the numbers in the fraction \( \frac{1}{2} \) now use the new font definitions, and the lower-case Greek letters \( \phi \) and \( \sigma \) are no longer italicized. You may want to use style definitions such as these for equations in a document in which the text is written in Arial or Tahoma. When printed, the equation will look like this:

\[ u = \phi \cdot \exp \left\{ \frac{1}{2} \sigma (x + y) \right\} \]

To reset the style definitions, open the Define Styles dialog and click “Factory settings”.


While working through this tutorial, you have probably noticed that each of the styles is also listed as a command on the Style menu. This allows you to explicitly assign a particular style to selected or subsequently-typed characters. The Other command on the Style menu can be used to assign any font available on your computer to selected or subsequently-typed characters. Please see Chapter 6 for further details.

**Tutorial 9: Equation Numbering in Microsoft Word**

This tutorial describes how to use the MathType commands for numbering equations in Microsoft Word documents. Although Word has its own method for numbering equations (captions), Word places captions above or below an item, not to the side, which is typically how equations are numbered. Using the MathType toolbar that’s added to Word, you can enter inline, display and numbered display equations with just one click.

We’re going to create the following portion of a document to illustrate the equation numbering commands.

We now have two basic equations:

\[ \cos^2 \theta + \sin^2 \theta = 1 \]  \hspace{1cm} (1.1)  
\[ \cos^2 \theta - \sin^2 \theta = \cos 2\theta \] \hspace{1cm} (1.2)

Adding these two together, we obtain

\[ \cos^2 \theta = \frac{1}{2}(1 + \cos 2\theta) \] \hspace{1cm} (1.3)

Subtracting (1.2) from (1.1) gives

\[ \sin^2 \theta = \frac{1}{2}(1 - \cos 2\theta) \] \hspace{1cm} (1.4)

Using (1.4) we can show that \( \cos 2\theta = 1 - 2\sin^2 \theta \).

However, we’re going to create it in a slightly unrealistic sequence, in order to illustrate the power and flexibility of the numbering commands.

1. Run Microsoft Word and create a new document.
2. Enter the following text: **We now have two basic equations:**
3. Click on the \( \text{Equation} \) button on Word’s MathType toolbar, or choose the Insert Numbered Display Equation command on the MathType menu.
4. A dialog will appear asking if you want to create a new equation section at the start of this document. We’ll explain equation sections later in this tutorial. For now, just click OK.
5. In the MathType window that opens, enter the following equation:

\[ \cos^2 \theta + \sin^2 \theta = 1 \]

then close the MathType window. In your Word document, notice that the equation is centered and the equation number is aligned with the right margin.

6. Repeat step 3 and insert the following equation into your Word document:

\[ \cos^2 \theta - \sin^2 \theta = \cos 2\theta \]

7. Enter the following text at the start of the next line: **Subtracting**

8. Now let’s insert a reference to the second display equation. Click the \( \text{equation reference button} \) on the MathType toolbar or choose the Insert Equation Reference command on the MathType menu. The Insert Equation Reference dialog will appear, displaying brief instructions about inserting an equation number reference. Once you are familiar with the process you can click the “Don’t show me again” box. For now, click OK, then double-click on the equation number (1.2). You’ll see that the number (1.2) is inserted into your sentence.

9. Type `from` and then enter a reference to equation (1.1) using the method described in step 8.

10. Then type `gives` and insert the following numbered display equation:

\[ \sin^2 \theta = \frac{1}{2} (1 - \cos 2\theta) \]

11. At the start of the following line, type **Using** and insert a reference to equation (1.3). Complete the line by typing **we can show that**.

12. Click the \( \text{equation reference button} \) on Word’s MathType toolbar, or choose the Insert Inline Equation command on the MathType menu, and insert the following equation:

\[ \cos 2\theta = 1 - 2 \sin^2 \theta. \]

Notice how this equation is inserted in the line of text (hence the name *inline equation*). Word also aligns the equation with the baseline of the text. Your document should now look like this:

We now have two basic equations:

\[ \cos^2 \theta + \sin^2 \theta = 1 \quad (1.1) \]

\[ \cos^2 \theta - \sin^2 \theta = \cos 2\theta \quad (1.2) \]

Subtracting \( \text{equation (1.2)} \) from \( \text{equation (1.1)} \) gives

\[ \sin^2 \theta = \frac{1}{2} (1 - \cos 2\theta) \quad (1.3) \]

Using \( \text{equation (1.3)} \) we can show that \( \cos 2\theta = 1 - 2 \sin^2 \theta \).

Now we’ll insert another equation in the middle of this example to demonstrate automatic renumbering.
13. Place the insertion point before the word Subtracting, and enter the following text: **Adding these two together, we obtain**

14. Insert this numbered display equation:

\[ \cos^2 \theta = \frac{1}{2} (1 + \cos 2\theta) \]

You’ll see that the new equation is numbered (1.3), and the following equation number and its reference have been renumbered to (1.4). Your document should now look like the example at the start of this tutorial.

Whenever you insert an equation number or an equation reference all numbers in the document are updated. However, if you move or delete an equation number, you must use the Update Equation Numbers command on the MathType menu to regenerate the number sequence. Also, be aware that deleting an equation number does not automatically delete all of its references.

### Equation Number Formats

You can also control the format of the equation numbers.

15. Choose the Format Equation Numbers command on the MathType menu (there’s no toolbar button for this command). Check the Whole Document checkbox (to change the existing numbers) and change the Enclosure option to <> (angle brackets). The preview shows you the result of your settings. Click OK, and you’ll see the equation numbers and references change to the new format. You may want to experiment with some of the settings — there are many possible combinations.

### Equation Sections

The default equation number format includes a section number and an equation number, e.g. (1.1). The section number is determined by the closest preceding Equation Section Break in your document. You insert and modify these breaks using commands on the MathType menu. We already inserted one at the start of this document as part of inserting the first equation number. Now we’ll change its value.

16. Choose the Modify Equation Section command on the MathType menu. The location of the section break will be highlighted and the Modify Equation Section dialog will open. You can modify the section number or delete it if you like. Choosing the “Next section number” option is useful if your document contains several sections and you want them numbered sequentially. In our case let’s assume we’re working on Chapter 2 of a book and we want the section number to be 2. Make sure the “Section number” button is selected, type 2 into the text box and click OK. The section break will be hidden again, and the equation numbers in the document will all start with 2.
If you’ve followed these steps your document should look something like this:

We now have two basic equations:

\[ \cos^2 \theta + \sin^2 \theta = 1 \]  \hspace{1cm} <2.1> \\
\[ \cos^2 \theta - \sin^2 \theta = \cos 2\theta \]  \hspace{1cm} <2.2> \\

Adding these two together, we obtain

\[ \cos^2 \theta = \frac{1}{2} (1 + \cos 2\theta) \]  \hspace{1cm} <2.3> \\

Subtracting \(<2.2>\) from \(<2.1>\) gives

\[ \sin^2 \theta = \frac{1}{2} (1 - \cos 2\theta) \]  \hspace{1cm} <2.4> \\

Using \(<2.4>\) we can show that \(2\cos \theta = 1 - 2\sin^2 \theta\).

**Tutorial 10: Setting Up a Microsoft Word Document**

When creating a Microsoft Word document containing equations there are several considerations you should keep in mind. You’ll probably want the body text to match the equations in terms of fonts and sizes, and you’ll typically want all equations in the document to use the same font and size settings, as well as any other special settings you may have made in MathType.

This tutorial shows you how to achieve these goals, and how to update the document’s equations if you decide to change your fonts and/or sizes.

Although Word and MathType allow you to select text and change its font and size directly, we strongly recommend that you make use of styles, instead. Both programs use this approach because it makes modifying the look of a document or equation very easy. You simply change the definition of a style (e.g. from Times New Roman to Arial, or from 12 pt plain to 10 pt italic), and your document or equation is immediately reformatted with the new settings.

Let’s assume that you’re required to produce a document where the body font is 10 pt Times New Roman. The first step is to define MathType’s settings to match the Word document.

1. In MathType, open the Define Styles dialog and set the main font to Times New Roman using either the Simple or Advanced pane. Make sure the “Use for new equations” box is checked, and click OK.

2. Open the Define Sizes dialog and set the Full size to 10 pt. As the other dimensions are by default expressed as percentages, MathType will calculate them for you. Again, check the “Use for new equations” option, and click OK.
3. Back in Word, choose the Set Equation Preferences command on the MathType menu. Make sure the “MathType’s ‘New Equation’ preferences” option is selected. This means that whenever you create a new equation using the commands on the MathType menu or MathType toolbar, the settings MathType is currently set to use for new equations are the ones that will be used. Click OK to close this dialog.

Note: you may not always want to rely on MathType’s ‘New Equation’ preferences. If you tend to change MathType’s size and style definitions quite often, you may want to create a MathType preference file, and then choose this file in the Set Equation Preferences dialog. This will copy the file’s preferences into your Word document, so that no matter what changes you make to MathType, equations created in your document will always use these preferences.

4. Now we’ll quickly create a Word style for the body of the document. Choose the Style command on Word’s Format menu, click New and name the new style “body”. You’ll probably base it on Word’s built-in normal style. Set the new style’s font to Times New Roman 10 pt by clicking on the Format button and choosing Font. Click OK to close the Font dialog.

Click on the Format button again and this time choose Paragraph. In the dialog’s Indents and Spacing page, change the Line Spacing option to Exactly, and type 12 pt in the accompanying text box. This forces Word to use this value when spacing lines of text, and prevents Word applying extra spacing around lines that contain inline equations. Click OK to close the dialog.

6. Click OK to close the New Style dialog, and then click Apply to close the Style dialog.

You’ve now configured Word and MathType to use the same font and size definitions, which will make equations closely match the look of the rest of the document. Go ahead and enter a line or two of text and insert a simple equation.

Now let’s suppose that, as so frequently happens, you have to change the document’s font to Garamond. To keep this example simple we won’t change the point size, but you’d follow the same steps if this were the case.

These are the changes we need to make:

- Modify Word’s “body” style to use Garamond instead of Times New Roman.
- Modify MathType’s styles to use Garamond instead of Times New Roman.
- Update the existing equations in the document to use the new font.

The first two steps are very similar to how we originally created the styles and added them to the Word document, so we won’t go through them in detail. The first step involves using Word’s Style dialog, the second step requires MathType’s Define Styles dialog.
The third step involves the Format Equations command on the MathType menu.

7. Choose the Format Equations command, and the Format Equations dialog will appear. This dialog allows you to reformat the equations in your document, and provides you with several ways to determine the equation preferences that are applied. The choices are:

- The equation preferences already stored in this document.
- MathType’s current equation preferences for new equations.
- The equation preferences contained in a MathType equation you’ve copied to the clipboard.
- The equation preferences contained in a MathType preference file.

For this example click the “MathType’s ‘New Equations’ preferences” button. You can click Preview to get a list of the actual preferences.

8. Click OK and the formatting process will start. This can take anywhere from a few seconds to several minutes depending on the speed of your computer and the number of equations in your document. The command’s progress is shown in Word’s status bar. When the operation has finished, check that the equations were updated.

Tutorial 11: Formatting with Tabs

In this example we show you how MathType’s system of tabs provides extra flexibility for formatting equations. We’re going to create the equation:

\[ c_n(x) = \begin{cases} \frac{1}{k} + 9.76x & \text{when } n \text{ is even} \\ 14.3x & \text{when } n \text{ is odd} \end{cases} \]

and then format it several different ways. We proceed as follows:

1. Create the expression on the left-hand side of the equals sign. As you know by now, you can choose the \( \text{subscript} \) template or press Ctrl+L to attach the subscript to the \( c \).

2. Choose the \( \text{left brace} \) template from the \( \text{palette} \) to insert an expanding left brace. You should now have the following:

\[ C_n(x) = \{ \cdot \cdot \cdot \} \]

3. Enter the top expression in the brace, up to and including the \( x \), and then press Ctrl+Tab (press the Tab key while holding down the Ctrl key). If you press the Tab key alone, this will move the insertion point, rather than insert a tab character.
4. Choose the Text style from the Style menu and type in \textbf{when n is even}. While you're using the Text style, the spacebar is active and you have to type spaces, as you would in a word processor. Choose Show All from the View menu, if it's not already checked, so that you can see your tab character, which is displayed as a small diamond. Also, choose Ruler from the View menu if it's not already checked. Your equation should look like this:

\[
c_n(x) = \begin{cases} 
\frac{1}{k} + 9.76x & \text{when n is even} \\
14.3x & \text{when n is odd}
\end{cases}
\]

Note that the tab character causes the phrase “when n is even” to line up underneath the first default tab stop to the right of the \(x\). The default tab stops (indicated by small inverted T’s along the Ruler scale) are positioned at half-inch intervals starting at the left-hand side of the current slot. Since we are currently within the main slot of the \(\text{[template]}\) template, the half-inch intervals are measured from the left edge of this slot, i.e. just to the left of \(\frac{1}{k}\).

5. Press \textbf{ENTER} to start a new line underneath the first one, and type in its contents. You should switch back to the Math style to enter \(14.3x\), and switch back to Text again to type \textbf{when n is odd}. Insert a tab character (CTRL+TAB) after the \(x\), as in the first line. This should give you:

\[
c_n(x) = \begin{cases} 
\frac{1}{k} + 9.76x & \text{when n is even} \\
14.3x & \text{when n is odd}
\end{cases}
\]

Again, the text phrase aligns with the first default tab stop to the right of the \(x\). Note that you have created a two-line pile within the \(\text{[template]}\) template, and that each pile in MathType has its own tab stops.

6. Select the \(n\) in the first line and choose Math from the Style menu. This makes MathType interpret the \(n\) as a mathematical quantity, i.e. a variable, and will therefore apply the Variable style (typically italic). Do the same to the \(n\) in the second line.
7. Place the insertion point somewhere within one of the two lines on the right-hand side of the equation, click on the tab well, and then click on the Ruler at about the 1½ inch mark to set a left tab stop. This will remove all default tab stops to the left of the new tab stop. Your equation should now be aligned as shown below:

\[
c_n(x) = \begin{cases} 
\frac{1}{k} + 9.76x & \text{when } n \text{ is even} \\
14.3x & \text{when } n \text{ is odd}
\end{cases}
\]

If this is how we want the equation formatted, then our work is finished. However, there are several other options that are worth exploring.

8. First, we’re going to align the two x’s. Insert a tab character (CTRL+TAB) at the start of each of the two lines. This will cause each line to be shifted so that its left-hand side aligns with the left tab stop. The text phrase in each line, since it is separated by another tab character, will align with the first available default tab stop to the right of the x.

9. Next, click on the tab well, and then click on the Ruler just to the left of the previous tab stop. This should produce the following results:

\[
c_n(x) = \begin{cases} 
\frac{1}{k} + 9.76x & \text{when } n \text{ is even} \\
14.3x & \text{when } n \text{ is odd}
\end{cases}
\]

You can now change the formatting easily by just dragging the tab stops around on the Ruler.

10. Next, we’re going to align the two decimal points. To prepare for this, first remove the tab by dragging it downwards away from the Ruler and then releasing the mouse button. Next, click on the tab well, and then click on the Ruler at around the one inch mark to set a decimal tab stop. Your equation should end up looking like this:

\[
c_n(x) = \begin{cases} 
\frac{1}{k} + 9.76x & \text{when } n \text{ is even} \\
14.3x & \text{when } n \text{ is odd}
\end{cases}
\]

That’s it for this tutorial, so delete your equation to be ready for the next tutorial.
Tutorial 12: Inserting Unusual Symbols

In this tutorial, you’ll learn how to use MathType’s Insert Symbol dialog to locate and use symbols that are not readily available in the built-in palettes. Suppose, for example, that you are going to be writing a document about some newly-invented operations on sets that are analogous to conventional union and intersection. You will want to find symbols to represent your new set operations, and it would be nice if these were similar to the conventional \( \cup \) and \( \cap \) symbols.

Your first attempt might be to use bold versions of the conventional symbols to represent your new operations, like this:

\[
A \cup B = \overline{A \cup \overline{B}} \\
A \cap B = \overline{A \cap \overline{B}}
\]

Unfortunately, the bold symbols look too much like the regular ones, so we’ll try to find a better solution.

1. Create the equations as shown above.

2. From MathType’s Edit menu, choose Insert Symbol. The following dialog will appear:

This dialog is somewhat similar to the one in Microsoft Word, and to the Windows Character Map accessory, which you may already know how to use.
You can use the Insert Symbol dialog to browse all the fonts available on your computer, and investigate MathType’s knowledge of them. Specifically, you can:

- Insert a specific character or mathematical symbol into your equation.
- Add a frequently used symbol to the toolbar.
- Add a keyboard shortcut for a frequently used symbol.
- Find a symbol by matching words in its description.

3. The first place to look for usable symbols is the Symbol font, so select Symbol from the list of fonts near the top of the Insert Symbol dialog. You can then scroll through the large grid of characters in the center of the dialog, looking for likely prospects.

4. You might also look in the Euclid Symbol and Wingdings fonts. Note that the Insert Symbol dialog tells you that Symbol and Euclid Symbol have the same “encoding” (arrangement of characters). So, if you don’t find the characters you need in one of these two fonts, you won’t find them in the other, either.

5. The Insert Symbol dialog actually provides a more intelligent way to search for the characters you need, rather just browsing through fonts. In the View by field, choose Description. Click on the New Search button, type the word union, and choose OK. The grid of characters will now show you several union-like symbols.

6. In the Insert Symbol dialog, uncheck “Show one of each” to see all the characters on your computer that MathType knows about, and which have the word “union” in their names. Depending on which fonts you have installed, there may be a few dozen such characters. If you are overwhelmed by the vast array of characters shown, click on “Show one of each” to reduce the number. This causes the dialog to display only one character (from the first font that contains it) for each description matched by the search criteria.

7. Click on a few of the promising-looking union characters, to see what MathType can tell you about them. Among other things, MathType will give you a description of the character, the font in which it was found, and the corresponding keystroke.

8. One of the characters you should see is a double union symbol \( \bigcup \) from the Euclid Math Two font. Let’s assume that we want to use this, provided we can find a corresponding symbol for intersection.

9. Using the techniques outlined above, search for symbols with “intersection” in their names. You should find a double intersection symbol \( \bigcap \), again in the Euclid Math Two font.

10. In the View by field, choose Font, and select Euclid Math Two from the list of fonts near the top of the Insert Symbol dialog. Scroll down to the bottom of the character grid until you see the \( \bigcup \) and \( \bigcap \) symbols. Nearby in the character grid,
you will see the square-shaped union and intersection symbols, $\square$ and $\cap$. Our search did not find these because their names are derived from the Unicode standard, which calls them "square cup" and "square cap" respectively.

11. You can click on Insert to insert symbols directly from the Insert Symbol dialog. However, if you’re going to be using them repeatedly, you’ll want to place them on one of MathType’s bars for easier access. Press (and hold down) the ALT key and drag the $\square$ character from the grid in the Insert Symbol dialog to the Small Bar. Then do the same for the $\cap$ symbol. See Tutorial 5 for more information about working with MathType’s toolbars.

12. Edit your equations to use the new symbols:

\[
A \cup B = A \cup B \\
A \cap B = A \cap B
\]

MathType knows all about the Euclid Math Two font, so it realizes that the $\square$ and $\cap$ symbols are binary operators, just like $\cup$ and $\cap$, and it puts the correct spacing around them automatically. If you use characters from more obscure fonts, you’ll have to take a few extra steps to get this automatic spacing to work. To learn more about MathType’s knowledge of fonts, and how you can extend it, see Chapter 7.

**Tutorial 13: Creating Equations for Web Pages**

This tutorial teaches you about creating web pages using equations. The most common approach is to create GIF equation files and insert them into your pages. As MathType can output GIF files, it is an excellent tool for creating equations for use in web pages. MathType will even generate the HTML (HyperText Markup Language — the basic language of the Web) needed to link your web page to the newly generated MathType GIF file. MathType-generated GIF files have several advantages over GIF files produced in other ways:

- They can be anti-aliased to produce better-looking smoothed edges.
- They are small (typically being monochrome), allowing for faster downloads.
- They can be edited at a later date in MathType.
- People can save the GIF file from the web page, open it with MathType and then place it into other documents in any of MathType’s supported formats (including WMF, EPS, \LaTeX, or even PICT on Macintosh computers).

**Inserting a GIF File Into a Document**

1. Run MathType and your HTML editing program.

2. In MathType, choose the Web and GIF Preferences command from the Preferences menu. This dialog contains options for setting the GIF file’s resolution (dots per inch), the image’s background, and the HTML code to...
generate when the GIF file is saved. For now, check the “Copy HTML/Text to clipboard on GIF file save” item.

3. Create a simple equation in MathType and choose Save As on the File Menu.

4. Select GIF File Format, type in the file name you desire, and save the equation in the same folder as your HTML document. MathType will generate HTML code for this equation and copy it to the clipboard.

5. Bring your HTML document to the front.

6. Place the insertion point where you want the equation to be inserted. If you are using a text editor you can paste the HTML into your document. If you are using a WYSIWYG HTML editor you will have to use its method for inserting plain HTML code (look for an “Insert HTML” or “View Source” command).

7. Save your HTML document and open it in your web browser. You will see the equation embedded in your web page.

You can anti-alias MathType equations to improve their appearance in web pages. This technique smoothes their edges and makes them look less jagged.

8. Switch back to MathType, open the Web and GIF Preferences dialog, check “Smooth edges (anti-aliasing)” and then close the dialog.

9. Save the MathType equation, then switch back to your browser and refresh the current page. You’ll see the appearance of the equation change. Anti-aliasing works better for some equations than others (in general it’s better on large equations than small ones).

The default HTML code generated by MathType includes the GIF filename and its dimensions, and is sufficient for most cases. You can modify this code in the Web and GIF Preferences dialog, consult this dialog’s Help for more details.

Saving an equation as a screen-resolution GIF image provides for fast downloads, but it will not print with laser-printer quality. For better printing, create the GIF at a higher resolution, at the cost of increased download time.

Getting an equation to align itself with the baseline of the surrounding text can be an art unto itself. As standards evolve and web browsers constantly change, it’s difficult to recommend a solution that works in all situations. MathML is a promising new standard for expressing math in web pages. MathType can generate MathML — see Tutorial 15 for more details. Check the MathType web site at www.mathtype.com for our latest recommendations on this subject.
MathType has built-in keyboard shortcuts for many of its commands, and the most commonly used symbols and templates. However, you can change any of MathType’s shortcuts, and you can also assign your own shortcuts for any items you place on the toolbar. See MathType’s online Help for a complete list of the built-in shortcuts.

We’ll start by defining a shortcut for a template that doesn’t already have one.

1. Let’s assume that you have to create several equations that include the \([\]) template (open brackets). MathType does not define a shortcut for this template. To assign one, first choose the Customize Keyboard command on the Preferences menu.

2. The Customize Keyboard dialog will appear. The panel titled Command: contains a hierarchical list of all the MathType commands that can be assigned keyboard shortcuts. We want to assign one to a toolbar item, so click on the + next to the Toolbar Commands category. An indented list will appear underneath Toolbar Commands. Click on the + next to Templates in this list, and then on the + next to Fence Templates.

3. Select the Open Brackets item (you may have to scroll the list down a little for this item to appear). The template \([\]) will appear in the panel next to the description so you can confirm you’ve selected the correct template.

4. Click in the edit box labeled “Enter new shortcut key(s)”.

5. Type CRTL+T, followed by [. Notice that a message appears below the box indicating that this shortcut is already assigned to the Left Bracket command. If we were to assign this combination to the Open Brackets template, it would be removed from the Left Bracket command. When assigning new shortcuts always check that you don’t accidentally overwrite an existing shortcut.

6. Press backspace once, and then type ALT+. This time there’s no current assignment. Now click the Assign button, and you’ll see the shortcut appear in the Current Keys list, as well as being appended to the Open Brackets item in the list of commands.

7. Click Close to close the dialog, then type CRTL+T followed by ALT+. You’ll see the \([\]) template appear in the equation window.
As there are so many commands available in MathType, both one-key and two-key shortcuts are supported. MathType defines shortcuts for many templates using the form CTRL+T followed by another character, which is why we used this particular combination. Of course, you’re free to define your own schemes as you see fit.

Assigning a Shortcut to a Toolbar Expression

8. Make sure the Small Tabbed Bar is visible and click on the Algebra tab. We’re going to assign a shortcut to the $\sqrt{2}$ expression, which should be the last item in the bar unless you’ve modified the contents.

9. Right-click on the item and choose the Properties command from the context menu that appears. In the Expression Properties dialog that opens you’ll see the same keyboard shortcut items we saw in the Customize Keyboard dialog.

10. Enter the shortcut ALT+R for this expression and close the dialog.

11. Type ALT+R, and $\sqrt{2}$ will be inserted into the equation window.

We could have assigned a shortcut for this expression using the Customize Keyboard dialog, but locating the command would have involved clicking on Toolbar Commands, Tabs, Tab 1, Small Bar, Expression 14. Right-clicking directly on the expression is a lot faster!

Tutorial 15: Working with \TeX & Other Languages

This tutorial teaches you how to convert MathType equations into textual markup languages, such as \TeX, \LaTeX, and MathML. Our main focus will be on \LaTeX, but techniques for other languages are very similar.

In creating your \LaTeX document, we assume you will be running MathType at the same time as your usual \TeX system.

Suppose you want to create the following paragraph in your \LaTeX document.

In the quadratic formula

$$x = \frac{-b \pm \sqrt{b^2 - 4ac}}{2a}$$

the discriminant $D = \sqrt{b^2 - 4ac}$ is the most important term

The steps are as follows:

1. Type **In the quadratic formula** in your text editor.

2. Run MathType by choosing it from your Start menu.

3. From MathType’s Preferences menu, choose Translators. In the dialog that appears, set the options as shown below, and then choose OK.
4. Create the quadratic formula in MathType.

5. From MathType’s Edit menu, choose Select All and then Copy.

6. Switch back to your text editor, and choose Paste. This will insert the following text into your document (as the translators are frequently improved the actual text may be slightly different):

   \[
   x = \frac{(- b \pm \sqrt{b^2 - 4ac})}{2a}
   \]

   If you are familiar with \LaTeX, you will recognize this as the \LaTeX source code for the quadratic formula.

7. Continue typing the discriminant, and then switch back to MathType.

8. Create the discriminant term $\sqrt{b^2 - 4ac}$.

9. In MathType’s Format menu, choose Inline Equation. This makes MathType generate the appropriate \LaTeX code for an inline equation.

10. Copy the equation and paste it into your text document, and then type is the most important term. Your document should now look something like this

   \[
   x = \frac{(- b \pm \sqrt{b^2 - 4ac})}{2a}
   \]

   the discriminant $\sqrt{b^2 - 4ac}$ is the most important term.
Translator Options

In many situations it is useful to be able to transfer old equations from a \TeX document back into MathType for editing or re-use. This is possible provided the equations were originally created in MathType with suitable translator options set. To understand the approach, choose Translators from MathType’s Preferences menu, and check the box labeled “Include MathType data in translation”. Now create the quadratic formula again and Copy and Paste it into your text document. This time, the resulting text will be

```
% MathType!MTEF!2!1!1!+-
% feaeeart1ev0aaekaacaWMbGaeeyypa0ZaaSaacmaacqGHiislc
% WGIbGaeyySae7aaOaaacacacWGIbWaaWbaaSqabeaacaaYaaaaOGa
% eyOeI0lGisaGiaadggacaWGLbaaleqaaGcbaGamaiaadggaca
% aaaa!DE70!
\{
 x = \frac{-b \pm \sqrt{b^2 - 4ac}}{2a}
\}
```

The first five lines of text (the ones starting with a % sign) are a \TeX comment containing MathType’s own private representation of your equation. You must select this comment, along with the code for your equation, when you want to transfer it back into MathType. When you paste this text back into MathType, it will automatically be converted back into a normal MathType equation. If you omit the comment, or change it in any way, the transfer back to MathType will not work. \TeX comments are ignored during the typesetting process, so they will have no effect on your final output.

MathType’s Translators dialog also provides the “Include translator name in translation” option, which helps to delineate and identify equations in your documents. This might be useful if you want to write programs that search your \TeX source files looking for equations and processing them in some way.

Other Translators

MathType includes translators for several dialects of \TeX (Plain \TeX, AMS-\TeX, \LaTeX, and AMS-\LaTeX). These dialects correspond to various packages of \TeX macros, which you must load before you typeset your document. For example, to typeset AMS-\LaTeX code, you must include the commands \documentclass[amsart] or \usepackage[amsmath], or some equivalent somewhere in the preamble of your document. Please consult your \TeX, or \LaTeX documentation for more details.

We also supply translators for several flavors of MathML, which is an emerging markup language based on XML (eXtensible Markup Language) for encoding mathematics on web pages. MathML is very new at this point, so there is very little software that supports the purely standard form. Therefore, MathType comes with three translators that produce somewhat non-standard, transitional...
forms of MathML that are supported by existing software packages (WebEQ, IBM Techexplorer, Amaya). A fourth translator generates completely standard MathML based on the STIX proposal. Depending on your needs and goals, you may either choose to use one of the software-specific translators to achieve better results in the short term, or to use the standard translator for better compatibility and support in the future. See MathType Help or visit our web site, www.mathtype.com for further description of our MathML translators.

Creating and Modifying Translators
If our standard translators do not meet your needs, you may want to modify one of them or write a new one of your own. Each translator is driven by a translation file written in our Translator Definition Language (TDL). You will find several TDL files in MathType’s Translators folder, and you can edit these to suit your needs, or write completely new ones. To obtain detailed documentation on writing translators visit our web site, www.mathtype.com.

What to do Next
This concludes the last of our tutorials. We certainly haven’t covered everything that MathType can do, but if all went well then you’ve grasped the basic principles. Chapter 5 contains additional information about using MathType with other applications. Chapters 6 and 7 cover MathType styles and advanced formatting. It’s not necessary to read them immediately, but once you’ve progressed beyond creating simple equations you’ll find them worth reading. The index is very complete, so it should be quite easy for you to find the information you need. If you get stuck, please get in touch with us — our contact information is listed at the very end of Chapter 1.
Chapter 5
Working with Other Applications

Introduction

This chapter describes the use of MathType with other applications. We discuss general methods for importing and editing equations, and also discuss specific techniques for using MathType with Microsoft Word and \TeX. If you are an experienced user and you’re familiar with the methods used to import different types of graphics into your word processing or page layout documents, you may not need to read the general information in this chapter at all. If you’re in doubt, you should read the introductory comments in the first few sections of this chapter to make sure you understand all the issues involved.

You can place MathType equations into documents created with a wide variety of applications, most of which are not discussed explicitly in this chapter. In general, you can easily insert MathType equations into any program that uses OLE to link with other components or applications, that allows you to paste graphics from the Windows Clipboard, or will import graphics in Windows Metafile (WMF), Encapsulated PostScript (EPS), or Graphic Interchange Format (GIF) file format.

Because we want you to have the latest information on new software as it is released, there are documents on the MathType web site that discuss using MathType with many of the latest software products. You can find these documents in the Technical Support area of the MathType site at www.mathtype.com. You can also find information on specific products in the MathType Help file included with your copy of MathType.

MathType and the MathType Server

You can run MathType as an application under Windows in the usual way or as a “server”. The purpose of the Server is to make MathType windows appear more quickly when you need them. In normal operation under Windows, any application currently running will have a window present on the screen. An application exits (i.e. quits completely) when all its windows are closed. However, by using the MathType Server, you can keep the MathType application running even when all its windows are closed. In effect, MathType is on stand-by, waiting to “serve” up the next equation. It stays in memory so that there will be no start-up delay when you need to create or edit an equation. If you insert a new equation into a document or double-click on an existing equation to edit it, a MathType window will open in an instant.
You can start MathType Server by using the MathType Server command in the MathType 4 submenu, located in the Programs submenu in the Windows Start menu. Alternatively, you can check “Startup in server mode” in MathType’s Object Editing Preferences dialog, so that MathType Server starts when you first create or edit an equation. This command is on MathType’s Preferences menu.

Inserting Equations into a Document

There are several ways you can insert equations into documents created by your word processor or other application. The method you choose depends on the capabilities of the application you’re using. Applications that support OLE (Object Linking and Embedding) are typically the easiest to use.

OLE is a Microsoft technology that allows applications to share data. Almost every Windows word processor, desktop publishing program and presentation program supports OLE. Using OLE, you can insert objects (e.g. equations) created by another application directly into your document. These objects are said to be embedded in the document. You can edit them using the original application (e.g. MathType) by double-clicking on them in your document.

The following list describes the various ways to insert equations. You can:

• Use the Insert Equation toolbar button in applications like Microsoft Word.
• Use the Insert Object command available in applications that support OLE.
• Cut and paste using the clipboard.
• Drag-and-drop using the mouse.
• Create graphic files using MathType’s Save As command, then import them into your document.

Insert Equation Toolbar Buttons and the Insert Object Command

If your application has a toolbar button to insert an equation, this is the simplest approach. Tutorial 1 in Chapter 4 provides an example using this method. The toolbar button is typically a shortcut for using the application’s Insert Object command. If your application doesn’t have such a toolbar button, you can probably find its Insert Object command on the Insert or Edit menus. The Insert Object command displays a dialog that lists all the types of objects you can insert into a document — choose “MathType 4.0 Equation” from the list and click OK. This will open a new MathType window ready for you to enter a new equation.

You insert an equation into your document by placing the insertion point where you want the equation, and then click the appropriate toolbar button, or use the Insert Object command as described above. Once you’ve created your equation, close the MathType window and your document, now containing your new equation, will become active again.
You simply double-click on an equation to edit it. Make your changes in the MathType window that appears, then close the MathType window to update your document.

**Cut, Copy, and Paste using the Clipboard**

You can copy all or part of an equation to the clipboard using the Cut or Copy commands on MathType’s Edit menu, and then Paste into your document. You can copy equations that are already in your documents either to another document or to a different place in the same document.

You edit an equation using Copy and Paste by selecting it in your document, copying it, and pasting it into a MathType window. After editing the equation, copy it, switch back to your document and paste it, being sure to delete the original. You can see how much easier it is to use OLE.

**Drag-and-Drop**

Drag-and-Drop is a more direct alternative to using the clipboard. You can use it to move or copy data within an application as well as between applications. Most modern Windows applications support Drag-and-Drop.

Before you can drag an equation to your document, make sure you can see your document’s window behind the MathType window. Select the equation, press the mouse button inside the selection and drag the selection over your document. Release the mouse when the insertion point is over the place in your document that you want the equation inserted.

Many people find Drag-and-Drop most useful while editing an equation, i.e. dragging and dropping pieces of an equation within a MathType window. Tutorial 5 in Chapter 4 describes how to drag equations or pieces of an equation to MathType’s toolbar.

**Saving Equations as Files**

You can use MathType’s Save As command to create equation files in several popular graphics formats:

- Encapsulated PostScript (EPS) — this format is used with desktop publishing programs like QuarkXPress and Adobe PageMaker.
- Graphics Interchange Format (GIF) — this format is used in web publishing.
- Windows Metafiles (WMF) — a standard Windows graphics format.

Many applications can import one or more of these graphics file formats. Which will give best results will depend on what you are trying to do. You will find more advice on this subject in the other sections in this chapter that describe how to use MathType with specific types of application, and in the Working with Equation Files section.

---

**Copying vs. Moving**

Hold down the CTRL key to make a copy when you drag. The pointer will include a small plus sign when you’re copying. Otherwise the item being dragged is moved to the new location (i.e. it is deleted from its old location).

**Equation Files**

No matter what file format you use to save equations, MathType can open them later for making changes and for use in creating new equations.
Moving and Resizing Equations in Documents

An equation that you have imported into a document is treated as a graphic picture or object by your word processing or page layout application. Most applications provide ways of moving and resizing graphics, and you can use these same techniques to modify MathType equations. In many applications, you can move equations horizontally either by using tabs or by adjusting paragraph formats and margins.

Resizing an Equation Object

You can resize an equation object by clicking on it to select it (see the tip to the left), and then dragging one of the “handles” (small black squares) on the box around the selected equation. Some applications (such as Microsoft Word) automatically keep the aspect ratio (ratio of height to width) of the graphic as you resize it. In other applications, you may need to hold down the SHIFT key while resizing to preserve aspect ratio.

If your application doesn’t support preserving the aspect ratio while you enlarge or shrink an equation, you may want to resize the equation in MathType using the Define command on the Size menu. Use a larger or smaller Full size to obtain the overall size you need. This will avoid the distortion that inevitably occurs when an equation is resized without maintaining the aspect ratio.

Inline Equations

Many word processing applications enable you to place a MathType equation within a line of text; that is, to produce an “inline” equation, as opposed to a “display” equation that has its own paragraph.

An equation imported into the middle of a sentence should sit level with the surrounding text, e.g. \( \sqrt{a^2 + b^2} \). To accomplish this, the baseline of the equation must be adjusted to match the baseline of the text. Most word processing and page layout applications handle this automatically. However, some do not. In this case, you may be able to manually adjust the baseline of the equation. Some applications enable you to adjust the vertical position of a selected equation using a subscript formatting command. If this works in your particular application, MathType can give you a hint as to the right distance to move the equation down. When you copy an equation to the clipboard from within the equation window, MathType will briefly display the baseline distance in points in the Status Bar. For example, if the Status Bar indicates “B=5”, then you will need to subscript your equation by 5 points after pasting it into your document.
Equation Numbering

If you use Microsoft Word, MathType adds commands to do most of the work involved in equation numbering for you. See Tutorial 9 for more details.

If you are not using Microsoft Word, you can format equation numbers using tabs. For example, using a centering tab stop in the center of your document and a right-align tab stop at the right margin produces the results in the picture below.

\[ u(x, y) = x^2 - y^2 \]  \hspace{1cm} (1.1)

Of course, different word processing applications may have different tab formatting capabilities. See your application’s documentation for more specific information on its tabs and alignment features.

Working with Equation Files

You can save a MathType equation into a file on your hard disk, either as a Windows Metafile (WMF), an Encapsulated PostScript (EPS) file, or a Graphic Interchange Format (GIF) file. You can then import those equation files directly into other applications. To save an equation file, choose Save As from the File menu, specify a name and location for the file, and choose the file format you want from the “Save as type” list. The available types are described below. You can use the Open command on MathType’s File menu to edit any equation files created by MathType.

WMF (Windows Metafile) Files

A WMF (Windows Metafile) file is the standard graphic format for Windows programs. As a result, it is one of the most useful file formats, since any Windows program that can import a graphic file can usually import a WMF file.

MathType uses fonts to represent all the characters in the WMF files it generates. This ensures that your equations will be displayed and printed with the highest possible quality. However, if you move your equations (or the documents that contain them) to another computer, you must make sure that the fonts they use are available, or the equations will not display or print properly.

EPS (Encapsulated PostScript) Files

EPS (Encapsulated PostScript) files consist of the Adobe PostScript page description language used to tell a printer how to print the equation. You can import EPS files into page layout programs like Adobe PageMaker and QuarkXPress. Because the language used is a printer language that is fairly universal, you can transfer equations in this format onto any other type of computer, including Macintosh computers running MathType for Macintosh.
When using the EPS file format, you have the choice of whether or not to include a screen preview graphic (either WMF or TIFF) with the file. You will usually want to include this screen preview because it allows the importing application to show something on the screen while you are editing your document. If you want to transfer the equation to a Macintosh computer that’s running MathType, you should save it in EPS format with a TIFF screen graphic. This format is just a plain text file and will avoid the graphics conversion problems you might encounter with other formats.

The method for importing equation files will depend on the program you’re using. See the sections on importing graphics or importing EPS files in your application’s user manual.

**GIF (Graphic Interchange Format) Files**

GIF (Graphic Interchange Format) is a standard format used for images on web pages, and is the only true bitmap format that MathType can produce.

Bitmap formats do not use fonts or languages; they simply define which dots to turn on to create the image. As a result, bitmap formats are completely transportable to any computer — whether the computer runs Macintosh OS, Windows, Unix, or any other type of operating system. A disadvantage of bitmap formats is that they do not print as well as formats in which MathType can use fonts. If you are creating documents for the purpose of printing, you should use high resolution (300 dpi or higher) GIF files, which may significantly increase the size of your document. If you are creating documents to be viewed electronically, screen resolution ( 72 or 96 dpi) GIF files are fine.

MathType provides several options that affect the kind of GIF image that is saved — resolution (dots-per-inch), transparency, background color, and smoothing. You can set these options using MathType’s Web and GIF Preferences dialog, in the Preferences menu.

Smoothing is a particularly interesting GIF option. It uses a graphics technique called anti-aliasing to smooth out the edges of characters and reduce “jaggies” by displaying some of the edge pixels using a color that is intermediate between the background and character colors.

**Automatically Numbering Files**

If you work with equations in individual files, you will probably create a lot of them. MathType has the ability to automatically number files that you save. This makes it easy to create a series of equations with filenames like Eqn1.wmf, Eqn2.wmf, Eqn3.wmf and so on. You can set the actual filename pattern in the Save As dialog. See MathType’s online help for more information on this feature.
Chapter 5: Working with Other Applications

Working with Microsoft Word

The combination of MathType and Microsoft Word is a powerful tool for creating technical documents. The level of integration that Equation Editor users are accustomed to is greatly enhanced by the MathType commands for Word, which add a toolbar and menu containing useful commands to Word 95, Word 97 and Word 2000 (and future versions).

This section provides a brief overview of these commands, references to more detailed information, a discussion of some Word formatting issues, and some recommendations on moving Word documents between Windows and Macintosh computers.

MathType’s Commands for Word

MathType Setup installs a Word template file into every Microsoft Word Startup folder it detects. The file is called “MathType Commands for Word XX” where XX is the version of Word e.g. 95, 97 or 2000. Copies of these files are also installed into the Office Support folder inside your MathType folder (this folder also contains a Read Me that contains additional information). This template contains several commands that greatly simplify the process of creating and editing documents containing equations. The commands are available in a MathType menu that’s added near the right-hand end of Word’s menu bar. Some of the more commonly used commands are also available in a MathType toolbar that behaves exactly like Word’s built-in toolbars.

The commands can be divided into the following categories:

- Inserting equations.
- Equation numbering.
- Controlling the appearance of equations in documents.
- Converting between equation formats.

Inserting Equations

The MathType menu in Word contains commands for inserting equations in three different ways: inline, display and numbered display. Inline equations are located within a line of text. Display equations occupy their own paragraph and are typically centered, while numbered display equations also include an equation number aligned with the right margin. We recommend that you use one of these commands to insert equations instead of using Word’s Insert Object command. They are more convenient, and they also make use of any equation preferences you may have set for your document (see below).
The first time you insert a display equation into a document, a Word style named “MTDisplayEquation” is created, and the paragraph containing the equation is formatted with this style. This allows you to control the formatting of all display equations in your document by changing this style.

**Equation Numbering**

Tutorial 9 shows how to use the equation numbering commands; here we present a brief overview and some additional tips. The MathType menu contains several commands for managing equation numbers and references. Although Word has its own numbering mechanism (captions), you may find these commands easier to use.

You can insert equation numbers in your document using the Insert Equation Number command (or the Insert Numbered Display Equation command). You can also create references to equation numbers using the Insert Equation Reference command. The numbers and references automatically update themselves whenever you insert a new equation number. Double-clicking on an equation reference jumps to the referenced number. References can also be placed in footnotes and endnotes.

MathType’s equation numbers consist of a section number and an equation number, an enclosure and a separator. The section number and the separator are optional, and the format of the numbers and the enclosure can be changed. This allows for many different numbers e.g. (1.1), [1], <A.1>, {1.i}. The Format Equation Numbers command lets you change the format of both new and existing equation numbers; it’s stored separately for each document.

If you want to use a section number as part of the equation number, you’ll need to use the Insert Equation Section Break command to insert an equation section break at the start of a section. Each break resets the section number component; you can choose to increment the previous value (useful if you have several sections in one document), or set it to a specific value (useful if each chapter in a book has its own document). These sections are not related to Word’s sections, they are only used by the equation numbering commands. Normally they’re hidden; if you want to see where they are in your document click the button on Word’s toolbar.

You can modify or delete a section break using the Modify Equation Section command. It searches backwards through your document, from the current location of the insertion point, looking for the preceding equation section break. The dialog allows you to change the section number; you can also delete the equation section break by clicking the Delete button.
Controlling the Appearance of Equations

Tutorial 10 in Chapter 4 shows how to maintain consistency between the look of your Word document and any equations it contains. This section briefly describes the issues and provides some recommendations.

Before starting on a new document, you’ll typically use MathType to define the fonts and sizes you want to use. Next, you’ll want to ensure that all equations you create in this document use the same settings. You can do this using the Set Equation Preferences command, located on the MathType menu in Word. It allows you to define which equation preferences MathType will use when you insert a new equation.

The choices are to use either MathType’s ‘New Equation’ preferences (as they’re set when you actually insert the equation), or a set of equation preferences that you can save with the document itself. If you tend not to change MathType’s ‘New Equation’ settings then you can use the first choice (which is the default), but if you do make changes, or you simply want to strictly enforce the preferences, you should use the second.

To do this, save a MathType preference file using MathType’s Save To File… command on the Equation Preferences sub-menu. Then, in Word use the MathType menu’s Set Equation Preferences command to load the preferences from this file. Note that the contents of the file are copied into your document. Consequently, once you’ve done this you don’t need to keep the preference file around. In fact, you can send your Word document to another MathType user, and your preferences will be used whenever they insert new equations!

MathType 4 equations contain the preferences with which they were created. However, equations created by previous versions of MathType (version 3.x and earlier) do not contain this information, and will be reformatted with MathType’s current preferences when you edit them. If you are going to edit an old document you can use the Format Equations command to update the equations. This will incorporate their preferences, just like new equations. Tutorial 10 contains an example of using this command.

Converting between Equation Formats

The Convert Equations command lets you convert all or some of the equations in your document into a different equation format. It can find MathType OLE equations, Word EQ fields and MathType text equations (e.g. \TeX or MathML) in your document, and convert them to either MathType OLE equations or MathType text equations. You can also update equations created by previous versions of MathType, so that you can now edit them by double-clicking.
MathType text equations are equations translated into a text representation using one of MathType’s translators. These equations can be converted back into MathType equations, or translated into yet another text equation. For text equations to be translatable, both the translator name and the MathType data must be included in the equation. You can ensure this by checking the appropriate boxes in the Convert Equations dialog. If just the MathType data is included, you can still copy and paste the equation into a MathType window.

In order to run as quickly as possible, the Convert Equations and Format Equations commands alter some Word settings. These are restored when the command finishes. In the unlikely event that the command runs into a problem and terminates prematurely, these settings will not be restored. The settings are “Typing replaces selection” and “Use smart cut and paste” in the Edit tab of the Options dialog (located on Word’s Tools menu). The commands turn both these settings off. You may want to reset them if you prefer otherwise.

Line Spacing in Word

When you insert inline equations into Word documents, you may notice that Word frequently increases the line spacing around the lines containing inline equations, even when it appears that no adjustment is necessary. This happens for any inserted graphic, not just equations, and occurs when Word’s line spacing is set to Single (the default setting), 1.5 Lines, Double, or Multiple. The result is that documents can contain uneven line spacing, which some people find undesirable. The effect is less noticeable the larger you set your line spacing.

An alternative is to use the Exactly setting. This keeps Word’s line spacing the same for every line, however some inline equations may have their tops and/or bottoms clipped off if they’re too large. The trick is to enter a value large enough for the inline equations you’re using, and to carefully check your printed output. A good starting value is one about 20% larger than the main point size of your document. For example, if your document is based on a 10 pt font, enter 12 pt for the line spacing setting. You make this change in Word’s Paragraph dialog, although as always we recommend that you create a Word style and define this style’s line spacing in this way rather than applying this setting to various paragraphs in your document as needed.

Transferring Word Documents between Macintosh and Windows Computers

You can transfer Word documents containing MathType equations between Windows and the Macintosh. Because of font differences between Windows and the Macintosh, you will need to refresh the document’s equations after transferring the document. For Macintosh documents that you’ve copied to your Windows computer, you can refresh the equations by using the Format Equations command (described earlier). On the Macintosh a similar command is available for Word 6, and for Word 98 and newer. For specific details please refer to your MathType for Macintosh documentation.
If you’re using the latest version of Word on each platform, you can typically save your document in the Word’s default document format. If you’re using an older version of Word for the Macintosh, you may need to save the document in a different format for it to be readable by the older version. Microsoft sometimes releases filters that allow older versions to read documents created by newer versions of Word. If you’re in this situation, you should try a few different formats until you find one that works. If you’re still having problems, check the MathType web site at www.mathtype.com.

Creating Equations for Web Pages

Tutorial 13 in Chapter 4 shows how MathType can be used to create GIF files for use on web pages. MathType also generates the HTML language needed to link your web page to the newly generated MathType GIF file. To save an equation as a GIF file, use the Save As command. Also, see the sections on GIF Files and Automatic File Numbering in this chapter.

Most HTML editors and web authoring tools, such as Microsoft FrontPage, have an Insert Image command that you can use to place an equation GIF file on the web page you are creating. See the user manual for your HTML editor for details on how to do this.

Customizing MathType’s Generated HTML

For most web applications, the HTML code generated by your HTML editor when you insert a graphic will work just fine. However, if you need to surround the HTML <IMG> tag with more sophisticated HTML code, you can make use of MathType’s “Copy HTML to clipboard” feature in the Web and GIF Preferences dialog. This feature allows you to set MathType up to copy an HTML code fragment to the clipboard every time you save a GIF file. This HTML code fragment can contain specialized code of your own design in order to make use of future web standards like Cascading Style Sheets (CSS) or to get around limitations in your HTML editor. See MathType’s online help for details.

Baseline Adjustment in HTML

Unfortunately, Web browsers don’t automatically handle baseline adjustment of inline equations. This means that your inline equations will not align themselves with the baseline of the surrounding text. We hope that this situation will improve in the future. There is a mechanism called Cascading Style Sheets (CSS) that helps, however its vertical alignment features have not been implemented in all of the popular browsers. Check our web site, www.mathtype.com, for the latest information.

Using Equations in Adobe Acrobat (PDF) Files

Another way to create documents for the Web is to create them in Adobe’s Portable Document Format (PDF). This is the format used by the Adobe Acrobat
reader and browser plug-in, which are freely available for many different platforms (see www.adobe.com/acrobat).

In order to create PDF files you will need the full version of Adobe Acrobat. A complete description of the process is beyond the scope of this manual, but we can give you a couple of hints.

Firstly, there are two methods for creating a PDF file; you can print your document using Adobe’s PDFWriter printer driver, or you can use Adobe’s Distiller application to convert a PostScript file into a PDF file. Version 3.x of the PDFWriter printer driver doesn’t handle symbolic fonts properly; as this adversely affects equations we recommend that you use the Distiller approach.

Secondly, you should always select the option to embed fonts in the PDF file. This ensures that your equations will be readable on computers that don’t have MathType’s fonts installed.

Using TeX, MathML, and other Translators

You can configure MathType to convert equations to text-based markup languages like \LaTeX and MathML using the Translators command on the Preferences menu. This dialog allows you to choose from a list of available translators, including several kinds of \LaTeX and MathML. Once you have chosen a translator, every time you copy an equation to the clipboard or do a drag-and-drop operation, the translator you chose will be invoked to convert the equation into text in the appropriate language.

Converting Microsoft Word Documents to \LaTeX

Although MathType cannot convert entire Microsoft Word documents into \LaTeX, it can perform part of the process. MathType’s commands for Microsoft Word allow you to convert all the equations in a Word document using one of MathType’s translators. If you save the resulting document as text, all you need to do to complete the task is add \LaTeX commands for formatting the paragraphs and headings.

Working with MathML

MathML is a new recommendation created by the World Wide Web Consortium (W3C, www.w3.org) for expressing mathematics in web pages. MathType installs four MathML translators that only differ in the MathML browser plug-in they are designed to work with: WebEQ, IBM Techexplorer, Amaya (actually a browser, not a plug-in), and STIX.

Working with MathML is much like working with \LaTeX — you run MathType at the same time as your favorite HTML editor and cut-and-paste (or drag-and-drop) equations between their windows. For the details of how you connect the MathType-generated MathML fragments to the MathML browser plug-in you
choose to use, please consult the plug-in’s documentation. There is more information on working with MathML in MathType’s online help. You may also find some help on the MathType web site at [www.mathtype.com](http://www.mathtype.com).

## Working with Paint and Draw Applications

### Importing Equations

You can import MathType equations into many drawing applications using their Insert Object commands, just as you would with your word processor. If available, this is usually the desired option as it provides the best chance of maintaining the print quality of the equations and allowing you to edit them later. However, some draw applications don’t have an Insert Object command, or there might be multiple ways to import the equation, each with a different effect on your document.

If the application doesn’t have an Insert Object command, then use Cut-and-Paste, drag-and-drop, or file import to insert the equation as a Windows Metafile (WMF). This will have all the benefits of the Insert Object command, except that, if you want to edit the equation later, you will have to use the clipboard again (or go back to the original equation file) instead of double-clicking on it.

Most paint programs will convert the equation into a bitmap as it’s imported. Once converted you won’t be able to edit it in MathType, so be sure to keep the original equation around if you want to avoid re-creating it.

### Problems with “Exploded” Equations

Some painting and drawing applications will “explode” an imported equation into the lines and text that make it up. In some cases, this may be what you want — to create some special graphical effect involving math, for example. If you are not interested in this happening, you should look for a better way to import the equation, as this “exploding” process has several disadvantages:

- The equation may be difficult to drag around and reposition.
- MathType’s internal information will be lost, making it impossible to bring the equation back into MathType for editing.
- The conversion process itself may be inaccurate, resulting in poor formatting and printing.

If you cannot bring equations back into MathType from your application, and if you think you might want to edit an imported equation at some later date, you should save it in a MathType equation file, in addition to importing it into your drawing document. You can then use MathType to edit the equation file, and replace the old equation in your document with the edited version. The format you choose when you save the MathType file is not important in this case, since MathType can open any file it creates, regardless of format.
An Alternative: Use your Word Processor Instead

An alternative to importing equations into a draw or paint application is to import your equations and other pieces of artwork (a graph you want to annotate with equations) into your word processor and arrange them as desired. This bypasses the limitations described above. If your word processor doesn’t have this capability, you can also use desktop publishing applications, like Adobe PageMaker and QuarkXPress, that have extensive importing capabilities and also allow imported graphics to overlap one another.

Working with Presentation Applications

You can use MathType to create presentations (slides, view-graphs, overheads, foils, or whatever you like to call them). You can add equations to a presentation just as you would in your word processor — use the Insert Object command.

You will probably want equations in slides to be larger than they would be in an ordinary document. There are two different ways to make larger equations, and we suggest that you experiment to find which method is best for you.

Resizing the Equation Using MathType’s Define Sizes Command

One approach is to use the Define command on the Size menu to assign larger point sizes to each typesize. If all the typesizes are defined as percentages of Full size (this is MathType’s default), all you have to do is change Full size to a larger point size then all the other sizes in the equation will adjust in proportion.

Resizing the Equation in the Presentation Application

Another approach is to simply create the equations in MathType as you would normally, then enlarge them to the size you want within the presentation document, making sure you maintain the aspect ratio of the equation graphic. You may find that this produces better-looking results than creating the equation with over-sized characters. However, if you resize each equation individually in this manner it may be more difficult to make all equations the same size; you will need to use the scaling capability of your slide or presentation application to specify the same scaling percentage for each equation. Also, line widths in fractions and radicals may not scale consistently, in which case you should use the previous approach.
Working with Desktop Publishing Applications

You can use MathType with desktop publishing applications, like Adobe PageMaker and QuarkXPress, to create professional quality technical papers, manuals, periodicals, and books. Like most good Windows applications, they support OLE, so you can insert equations using the Insert Object command. You can also insert equations saved as EPS files.

Color and Professional Publishing

Professional publishers often work with precisely defined colors in their documents, usually naming them based on a color standard like Pantone. If you’re going to import MathType equations into such a document, simply define MathType’s colors to match those of the document. This is easy to do using MathType’s Edit Color Menu command on the Color submenu of the Format menu. The names of colors are particularly important, since MathType adds these names to the EPS files it creates. When you import the EPS file into the document, PageMaker and QuarkXPress will match up like-named colors in the equation with those of the document so they are considered to be the same color.

Working with non-Windows Computers

Like many other applications, MathType has versions for both Windows and the Macintosh, and the two versions are compatible. You can copy whole documents containing equations if the application that you used to create them is also available on the other platform. Even if the original application isn’t available, you may be able to import the document into another application. If copying the entire document isn’t possible, you can save the equations as files using MathType’s Save As command and then copy the files to the other platform. If you have MathType available on the other platform, you can open the equation files there.

Transferring Equation Files to and from non-Windows Computers

The best formats to use when copying equation files to other platforms are Encapsulated PostScript (EPS) and Graphics Interchange Format (GIF) as these file formats are somewhat universal. If you decide to use EPS and want to include a screen graphic, save the file with a TIFF graphic; the WMF graphic is generally not transportable. EPS with no graphic will also work.

The GIF format will work on any computer system but, as it is a bitmap format, it will not print well unless you save it at a high resolution.

Transferring Microsoft Office Documents to and from the Macintosh

If you have Windows and Macintosh versions of Microsoft Office products, you can transfer documents containing equations between platforms. Equations contained in these documents will be converted into the graphic format of the...
current platform. For the best results, however, you will need to “refresh” the equations after you transfer the document. This process reformats each equation using the fonts on the current platform, and is necessary to obtain the correct spacing of the characters in the equations (even fonts with the same names often have slightly different character shapes and sizes on each platform).

You can refresh equations by double-clicking on them, choosing MathType’s Update command, and then closing the MathType window. If you use Microsoft Word and transfer documents from the Macintosh to Windows, all of the equations can be refreshed with one command — see the section in this chapter on Microsoft Word for details. Also, any fonts used in the equations must be available on both platforms; otherwise, you will have to choose new fonts for the equations after the transfer.
Chapter 6
Fonts, Styles, Sizes and Spacing

Introduction

This chapter tells you how MathType assigns fonts, styles, sizes, and spacing to the characters in equations and how you can change the automatic assignments to give your equations a different look.

Styles

Each character in a MathType equation is either assigned a specific font and character style, or is assigned one of eleven “styles.” MathType’s styles are somewhat analogous to text styles in word processing and page layout applications. Each one is defined as a combination of a font and character style (e.g. Times, bold & italic or Symbol, bold). Styles save you from having to worry about fonts and character styles separately, and hence speed up your work and help you maintain consistency in your equations. Also, by changing the definition of a style, you can quickly change the appearance of all the characters that use it. You can change the definitions of any of the styles using the Define command on the Style menu.

The Primary Font

In most kinds of documents, you will choose a font, character style (bold, italic), and point size for the main body of the text in your document. We call this the “primary font”. Usually, you will want your equations to be based on the primary font — functions, like “sin” and “cos” will be in the primary font, as will numbers, variables will share the same font, but in italic, and so on.

The following subsections describe each of MathType’s eleven styles and how they are used:

Math

Math is not a style in the same sense as the other styles, although we tend to refer to it that way occasionally in this manual. Rather, it is a mode which causes MathType to automatically assign the appropriate style to function names, variables, symbols, and numbers as you type. The Math style is discussed further below in the section entitled Function Recognition.
Text
You should use the Text style when you want to enter words rather than mathematical formulas. You will normally define your Text style to be the same font and character style as your primary font.

When the current style is Text, MathType behaves somewhat like an ordinary word processor. However, we do not recommend using MathType to write large amounts of text (it isn’t a word processor!); the Text style is provided only to make it easier for you to occasionally type a few words that might occur in the middle of an equation.

A few word processors will not allow you to place an equation (or any other graphic) within a line of text. If you run into this problem, you may have to create the entire line of text, including the equation, in MathType. Use the Text style to type the text, and create the equation within it using the mathematical styles, as usual. You can then copy the entire line from MathType into your document.

Function
The Function style is meant to be used for the names of standard mathematical functions, like sin, log, etc. You will normally define your Function style to be the same font and character style as your primary font. MathType automatically recognizes standard mathematical functions, and you can also add your own. See the “Function Recognition” section later in this chapter.

Variable
The Variable style is used for alphabetic characters representing ordinary mathematical variables and constants in your equations. You will normally define your Variable style to be the same font as your primary font, but with italic character style.

Lower-Case Greek
The Lower-Case Greek style is used for lower-case Greek characters. It is usually defined to be the Symbol or Euclid Symbol font with italic character style.

Upper-Case Greek
As you might expect, the Upper-Case Greek style is used for upper-case Greek characters. It is usually defined to be the Symbol or Euclid Symbol font, but its character style is a matter of personal taste — some people like to have their upper-case Greek characters italicized, and some people don’t.

Symbol
The Symbol style is used for many mathematical operators, such as + and =, for summation and product signs, and for other special characters. In order for MathType to work correctly, the Symbol style must be defined to be the Symbol
font, the Euclid Symbol font, or some other font with exactly the same font encoding as Symbol (i.e. the same set of characters in the same positions).

**Vector-Matrix**

The Vector-Matrix style is used for characters representing vector or matrix quantities. It is usually defined to be the same font as the Variable style, but is given a bold character style instead of italic. Some people like to use sans-serif fonts, such as Arial or Helvetica, to denote vector or matrix quantities.

**Number**

Not too surprisingly, the Number style is used for numbers, i.e. any of the ten digits, 0–9. You will probably want it to be the same as the primary font. If you are making tables with columns of numbers, you should define your number style to be a font in which all the numerals are the same width, so that your columns line up properly. Most fonts have this property, even ones like Times, whose alphabetic characters have proportional widths, but a few do not.

**User 1 and User 2**

The User 1 and User 2 styles are provided so that you can set up your own font and character style combinations and assign them to characters quickly and consistently. These styles may be used for special notation, such as an alternative character style for variables, or for assigning some font that contains special symbols. If you assign a font to one of these styles, you can insert any character from the font into an equation by choosing the User 1 or User 2 command and then pressing the key(s) corresponding to the character. This is a good alternative to placing special symbols on the toolbars (as described in Chapter 6), when you want quick access to a special alphabetic font. For example, you might use Euclid Math One for script characters (e.g. \( \mathcal{F} \), \( \mathbb{L} \), \( \mathfrak{P} \)) or Euclid Fraktur for “gothic” characters (e.g. \( \mathfrak{A} \), \( \mathfrak{M} \), \( \mathfrak{X} \)).

**Automatic Style Assignment**

As we mentioned above, MathType will often assign certain styles to certain kinds of characters automatically, based on its knowledge of mathematics and typesetting conventions. There are two mechanisms that cause this to happen: function recognition and character substitution.

**Function Recognition**

When your current style is Math (which will be most of the time), MathType will automatically recognize standard mathematical functions, like “\( \sin \)” and “\( \cos \)”, and display them using the Function style. In addition, MathType will automatically insert thin spaces around functions, according to the rules of mathematical typesetting.
Character Substitution

If your current style is Math, Variable, Function, Vector-Matrix, or Greek, then MathType will sometimes substitute different characters in place of the ones you type on your keyboard. One important example of this is the minus sign; MathType will insert a real minus sign from your Symbol style, instead of the hyphen that most fonts have instead. Minus signs are about twice as long as hyphens, so this makes a noticeable difference.

Several other characters are also replaced by the corresponding ones from your Symbol style: examples include parentheses, brackets and braces, and + and = signs. This generally improves consistency and results in better-looking equations. Finally, whenever you type a numeral, MathType will use the Number style.

On the other hand, if you have explicitly selected a font and character style (using the Other Style command), or if your current style is Text, User 1, or User 2, then substitution is not performed, so you always get exactly the character you ask for, rather than the one that MathType thinks you need.

Explicit Style Assignments

For most equation typing tasks, you will use MathType’s Math style, but will change to Text style to add an English sentence or phrase. Sometimes you might want to explicitly assign either a style or a font and character style to text, overriding MathType’s automatic style assignments. You do this in more or less the same way as in a word processor — you can either change the current style (or font) to the desired one before you begin typing, or you can assign a style to selected characters after you type them. In both cases you choose the desired style from the Style menu. Of course, there are keyboard shortcuts for all these operations.

Style Changes that Affect the Next Typed Character

If you want to set the style of the very next character you type, MathType provides a few handy keyboard shortcuts that we call “one-shots”. The big advantage to these shortcuts is that you don’t have to switch back to your previous style after you type the character — MathType will do it for you!

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Assigns this style to the next character typed</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRl+G</td>
<td>Greek</td>
</tr>
<tr>
<td>CTRl+B</td>
<td>Vector-Matrix</td>
</tr>
<tr>
<td>CTRl+U</td>
<td>User 1</td>
</tr>
<tr>
<td>CTRl+ALT+U</td>
<td>User 2</td>
</tr>
</tbody>
</table>

Escaping

After you type a one-shot shortcut, the Status Bar tells you that you have temporarily placed MathType in a special mode, ready for you to type the character to get the corresponding style. If you change your mind, just press Esc.
Chapter 6: Fonts, Styles, Sizes and Spacing

Typesizes

Normally, MathType will automatically determine the proper point size to use for the characters in your equations as you create them. This is unlike typical word processors, where you normally choose a specific point size for your text. MathType does this using a system of five “typesizes” (Full, Subscript, Sub-subscript, Symbol, or Sub-symbol) that it automatically assigns to characters, based on their position in the equation. One of the advantages of this scheme is that you can change the size of all your subscripts and superscripts, for example, by simply assigning a different point size to the Subscript typesize. For more on this, see Automatic Size Assignments later in this chapter. Like all good software, MathType allows you to override its automatic choices — see Explicit Size Assignments later in this chapter.

Each typesize can be defined either as a specific point size or as a percentage of the Full typesize. In MathType’s default settings, only the Full typesize is actually set to a specific point size — the others are defined as percentages of Full. This way, you can change the overall size of the text in your equation by simply changing the Full typesize (using the Define command on the Size menu). All the other sizes will adjust in proportion. For most equations, you will want to define the Full typesize to be the same point size as the body text of the document for which they are intended.

The following subsections describe each of MathType’s seven typesizes and how they are used:

**Full typesize**

Assigned to ordinary characters within most slots. This typesize corresponds to the size of text in the body of your word processing document.

**Subscript typesize**

Used for subscripts and superscripts attached to Full typesize characters. Also used in limits in integrals, summations, and other templates.

**Sub-subscript typesize**

Used for subscripts and superscripts to Subscript typesize characters or any other place a second level of size reduction is required. Also used for limit slots of templates inside the limits of other templates. For example, the Sub-subscript typesize would be used for a superscript occurring within a limit of integration.

**Symbol typesize**

Used for the oversize symbols in integral, summation, and product templates.

**Sub-symbol typesize**

Used for oversize symbols in Subscript typesize slots.
User 1 typesize
A general-purpose typesize to be used for whatever you want.

User 2 typesize
A second general-purpose typesize.

Automatic Size Assignments
Each slot in a MathType equation has a typesize associated with it. When you insert characters into a slot, they are assigned the typesize of that slot. When you insert a template into a slot, the typesizes of the new slots are based on the typesize of the existing slot. For example, if an integral template is inside a Subscript typesize slot, its integrand slot is Subscript typesize, its integral sign is Sub-symbol typesize, and its limits are in Sub-subscript typesize. Although you may nest templates within templates to many levels, the typesizes automatically assigned to slots will never be any smaller than the Sub-subscript typesize, in accordance with standard mathematical typesetting rules.

Explicit Size Assignments
For most equation typing tasks, you will allow MathType to automatically assign typesizes to characters. Sometimes you might want to explicitly assign either a typesize or an explicit point size to characters, overriding MathType’s automatic typesize assignments. You do this in more or less the same way as in a word processor — you can either change the current size to the desired one before you begin typing, or you can assign a typesize or point size to selected characters after you type them. In both cases you choose the desired typesize from the Size menu (using the Other command for an explicit point size). Of course, there are keyboard shortcuts for all these operations.

Spacing
MathType’s formatting algorithms are controlled by a number of spacing dimensions, or measurements. These include subscript depth, numerator height in fractions, fraction bar overhang — thirty dimensions in all. You can adjust the values of any of these dimensions by using the Define Spacing command on the Format menu. This command displays a dialog that lets you scroll through the list of dimensions and change the values of any of them. For each dimension, it shows you a picture that illustrates the aspect of equation formatting that it affects.
Chapter 6: Fonts, Styles, Sizes and Spacing

Units of Measurement

When entering new dimension values in MathType’s Define Sizes or Define Spacing dialogs, you should understand MathType’s system of units. There are four units of measurement available:

<table>
<thead>
<tr>
<th>Units</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>inches</td>
<td>in</td>
</tr>
<tr>
<td>centimeters</td>
<td>cm</td>
</tr>
<tr>
<td>points</td>
<td>pt</td>
</tr>
<tr>
<td>picas</td>
<td>pi</td>
</tr>
</tbody>
</table>

It’s often a good idea to specify a dimension as a percentage of your Full typesize, because then you won’t need to change it in the event that you change typesizes. As an example, suppose your Full typesize is defined as 12 points. If you set your Subscript Depth dimension to 25%, then your subscripts will be shifted 3 points below the baseline, but if you later change your Full typesize to 10 points, your subscripts will be shifted down only 2.5 points.

Equation Preferences

The definitions of all the styles, sizes, and spacing used in an equation are referred to collectively as “equation preferences”. The equation preferences used to create an equation are saved with that equation. Changes you make using the Define Styles, Sizes, and Spacing dialogs in one equation will not be reflected in equations you have already created. However, if you leave the “Use for new equations” box checked in each of these dialogs, MathType saves the equation preferences in a special place. The next time you create a new equation, it will start off with those preferences.

There is a more advanced technique, discussed below, that allows you to save equation preferences in a file. You can then use this file to set the preferences of any equation you create in the future.

Using Preference Files

MathType’s Preference files are somewhat analogous to style sheets in a word processing application. They provide a quick and consistent way to switch between various MathType configurations of styles, sizes, and spacing as set using the Define Styles, Define Sizes, and Define Spacing dialog boxes.
The ability to quickly change style definitions is the most basic example of the use of multiple Preference files. Suppose you generally write equations in Times New Roman, but for a particular type of document you want to use Arial instead. You can create two Preference files: one in which the Text, Function, Variable, Vector-Matrix, and Number styles are defined as Arial (with the appropriate character styles), and the other in which these styles are defined as Times New Roman. Then, by using the Load Preferences command, you can quickly set up the desired style definitions for either type of document by choosing the corresponding Preference file.

**Saving and Loading Preference Files**

To create a Preference file, first set up the styles, sizes, and spacing as you would like to save them. Then, choose Save To File from the Equation Preferences submenu of the Preferences menu. A dialog box will appear, allowing you to name the file and specify its location. It might be a good idea to save each Preference file in the same directory as the documents that use it. Or, you may want to use the Preferences folder in the MathType folder.

To load a Preference file, you can either choose Load Preferences from the Equation Preferences submenu of the Preferences menu and use the dialog box to locate the desired file, or, if the file is one of the four most recently used, you can load it by choosing its name from the bottom of the Preferences menu. When you load a Preference file, all the settings it contains will be immediately applied to the current MathType window. A dialog box also appears, which lets you apply these settings to new equations as well. Remember that this includes styles, sizes, and spacing definitions.

**Installed Preference Files**

MathType Setup installs a set of preference files that we’ve put together to show you how you might make use of this feature. They’re in the Preferences folder inside your MathType folder. The names are self-explanatory — Times+Symbol 10.eqp sets the primary font to Times New Roman, the Math/Greek font to Symbol, and Full size to 10 pt. The Euclid-based preference files use Euclid as the primary font and Euclid Symbol for the Math/Greek font. TeXLook.eqp is based on Euclid 10.eqp, but we’ve also adjusted some spacing settings to generate equations with a look similar to that of TeX.

**Factory Settings**

Sometimes, especially if you are a new MathType user, you may want to restore MathType’s styles, sizes, and spacing to the settings that were in use the first time you ran it. You can do this for all of the equation preferences at once by choosing Load from Factory Settings from the Equation Preferences submenu of the Preferences menu.
Chapter 7
Advanced Formatting

Introduction

MathType’s automatic formatting will produce good results most of the time. However, it’s impossible for MathType to always know what you intend, or what an equation means. After all, MathType isn’t a mathematician and hasn’t read your entire document! This chapter describes some of the techniques that are available for doing more advanced formatting tasks. It also discusses MathType’s built-in font and character knowledge and how you can extend it.

Overriding Automatic Spacing

If you have a current style that is something other than Text, User 1, or User 2, the spacebar is disabled in MathType, so that accidentally pressing it will not interfere with MathType’s automatic formatting. However, you can still insert spaces of various sizes by choosing space symbols from the Symbol Palettes. You can also insert spaces using keyboard shortcuts, as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Keystroke</th>
<th>Alternative Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>SHIFT+SPACE</td>
<td>CTRL+K,0</td>
<td>Zero space</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>CTRL+ALT+SPACE</td>
<td>CTRL+K,1</td>
<td>One point space</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>CTRL+SPACE</td>
<td>CTRL+K,2</td>
<td>Thin space (sixth of an em)</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>CTRL+SHIFT+SPACE</td>
<td>CTRL+K,3</td>
<td>Thick space (third of an em)</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>None</td>
<td>CTRL+K,4</td>
<td>Em space (quad)</td>
</tr>
</tbody>
</table>

Inserting spaces explicitly will override any automatic spacing that may be in effect at the location where you insert the spaces. You will get exactly the spacing you input explicitly. If you remove the explicit spaces, then the automatic formatting will go back into effect.

In full-size slots, MathType uses thick spaces around relational operators such as = and ≤, and around arithmetic operators such as + and −; these spaces are not used when the operator is in a reduced-size slot such as a subscript. Thin spaces are often used between function abbreviations and their arguments, as in y = log sin x.
You should manually insert thin spaces between differentials and other symbols, as in \( dy \times dx = r \times dr \times d\theta \). MathType thinks that \( dy \times dx \) is \( d \) times \( y \) times \( d \) times \( x \), and will not insert the thin space, so you have to insert it yourself.

You may also have to adjust MathType’s spacing if you like to write open intervals in the form \( [a, b] \) or \( [a, b] \), rather than \( (a, b) \) or \( [a, b) \). For example, if you type all the \( [ \) symbols directly from the keyboard, the spacing in a formula like \( [0,2] = [0,1] \cup [1,2] \) will not be correct. MathType will perform the spacing correctly if you use the \( [\)] \ template, rather than typing the brackets. Similar considerations apply to vertical bar symbols representing absolute value: if you type the bars as characters from the keyboard, rather than using the \( || \) template, then you may have to adjust the spacing yourself.

Another possible cause of a spacing error is typing an English word that includes a function abbreviation while your current style is Math. For example, if you try to type the word “single”, MathType will interpret this as the sine of \( g \) times \( l \) times \( e \), and will produce something like “\( \text{sin gle} \)” or “\( \text{sin gle} \)”. The latter of these two might be acceptable if it were not for the thin space that was inserted. You can avoid this type of mistake by choosing Text from the Style menu before you begin typing a word. Alternatively, you can correct the situation later by selecting the offending word and then choosing the Text command from the Style menu.

**Nudging**

MathType’s Nudge commands allow you to exercise fine control over the placement of items in an equation. To nudge an item, you select it, and then use one of the following commands:

- `CTRL+←` nudges the selected items to the left by one pixel
- `CTRL+↑` nudges the selected items upward by one pixel
- `CTRL+→` nudges the selected items to the right by one pixel
- `CTRL+↓` nudges the selected items downward by one pixel

The selected items are moved in small increments in the indicated direction. The size of the increment depends on the current display scale. If you’re viewing your equation at 100% scale the increment is 1 pt, \( \frac{1}{2} \) pt at 200%, \( \frac{1}{4} \) pt at 400%, and \( \frac{1}{8} \) pt at 800%. These commands are for fine adjustments only — if you nudge things too far, you may have trouble selecting them, and the Show Nesting view will produce confusing results.
Nudge commands have many uses. By moving one character on top of another, you can form overstrikes and other special combinations of characters, such as \( \star \) or \( \cdot \).

You can also use Nudge commands to improve upon MathType’s built-in kerning capability: for example, in an expression like \( L^1 \), the superscript may look better if you move it further into the gap in the \( L \).

The Nudge commands can be especially useful when applied to symbols such as brackets and embellishments that are parts of templates. Recall that there is a special technique for selecting symbols of this type: hold down the CTRL key and click on the symbol with the vertical arrow pointer. Sometimes you may wish to nudge an embellishment to place it at the same height as some other one nearby.

Although you cannot “undo” nudging, you can return nudged items to their original, un-nudged positions by using the Reset Nudge command on the Format menu. The Reset Nudge command can be used at any time — it is not necessary to choose it immediately after nudging. Prior to choosing the Reset Nudge command, you must select the nudged items you want to reset. Selecting items that were previously nudged usually requires keyboard techniques. Use the TAB key to cycle the insertion point until it lands in the appropriate slot, and then hold the SHIFT key down while moving the insertion point with the arrow keys to select the desired items.

**Fence Alignment**

MathType’s fence alignment feature allows you to easily adjust the alignment of items within fences (brackets, parentheses, braces, etc.).

In most technical publishing, fences are centered with respect to the math axis (the height where the horizontal strokes of minus signs and addition signs are located) both inside and outside of the fence. This doesn’t always look exactly the way you want it, though. For example, the case below:

\[
H = \left\{ \frac{M + \frac{A + B}{P - R}}{3Q} \right\}
\]

The numerator in the above expression is much taller than the denominator, resulting in a large white gap at the bottom of the expression. To get rid of that gap, you will want to change the fence alignment setting of the brace template. Place your cursor somewhere inside of the brace or select the entire template, and choose the Fence Alignment command from the Format menu.
Using the same example, there are three possible settings for fence alignment:

\[ H = \left\{ \frac{M + A + B}{P - R} \right\} \quad \text{or} \quad H = \left\{ \frac{M + A + B}{P - R} \right\} \quad \text{or} \quad H = \left\{ \frac{M + A + B}{P - R} \right\} \]

Notice the positions of the math axis outside of the braces, the math axis inside of the braces, and the center of the brace character itself. Each choice has its own advantages and disadvantages, and the correct selection will most likely depend on the expression inside the braces and its relationship with the rest of your equation.

You can also choose the fence alignment setting that will be used for new fence templates using the Fence Alignment command. Remember, no matter which fence alignment setting a template starts out with, you can still change it later on a template-by-template basis.

### Changing the Font of Individual Characters

The fonts used in equations are generally based on MathType’s system of styles, but you can also assign any font available on your computer to specific characters in an equation. For example, you may want to incorporate characters such as the \( \mathfrak{M} \) or \( \mathfrak{X} \) from Euclid Fraktur into your equations. Or, you may have some font containing technical symbols used occasionally in your documents.

You can incorporate special fonts into your equations by using the User 1 or User 2 styles, or the Other command on the Style menu. Assigning the font to one of the User styles is often the more convenient approach, because you can then access the font by choosing the corresponding style from the Style menu, perhaps via a keyboard shortcut. The User 1 and User 2 styles are described further in Chapter 6.

The Other command on the Style menu allows you to assign any font to selected (or subsequently typed) characters. When you choose the command, a dialog box appears with a list of available fonts. You simply select the desired font and then choose the OK button. For example, suppose you wanted to insert the \( \mathfrak{v} \) character from the Wingdings font. This character corresponds to the \( \text{v} \) keystroke in this font (see the next paragraph). So, to insert the character, you would type a \( \text{v} \) and select it, then choose Other from the Style menu and select Wingdings.

The Insert Symbol command on the Edit menu can help you determine the keystrokes corresponding to characters in a given font. The Insert Symbol dialog displays a table of all the characters in a specified font. When you click on a character, the corresponding keystroke is indicated in the lower right-hand corner of the window. Some of the keystrokes are of the form “\( \text{ALT} + 0123 \)” with various numbers in the place of 0123. This means that to insert the character, you
hold down the ALT key and enter the numbers one at a time from the numeric keypad, then release the ALT key.

**Changing the Size of Individual Characters**

You can change the size of most characters in equations to any size you want. The Other, Smaller, and Larger commands on the Size menu can be applied to selected characters or to characters you type subsequently. The Other command displays a dialog box which allows you to enter any point size. The Smaller and Larger commands change the size of selected or subsequently-typed characters by one Smaller/Larger Increment (this increment is specified in the Define Sizes dialog box). If you want to resize a summation sign, embellishment, or some other symbol that is part of a template, remember that there is a special method for selecting these characters: hold down the CTRL key and click on the symbol with the vertical pointer, as shown below. Keyboard shortcuts for the Smaller and Larger commands are CTRL+SHIFT+< (Smaller) and CTRL+SHIFT+> (Larger).

\[
y^{\infty} \sum_{i=1}^{\infty} a_i
\]

You cannot assign a specific typesize to expanding brackets and braces or expanding integrals; the sizes of these characters can only be changed using the Smaller and Larger commands.

**Choosing Fonts for Math Documents**

Choosing which fonts to use in your documents is largely a matter of personal taste, but there are some general guidelines that you might want to follow.

**Serifs vs. Sans Serif**

For writing technical documents, fonts having serifs (small horizontal strokes at the tops and bottoms of characters) are usually preferred to those that do not. Among the well-known fonts, Times, Bookman, and New Century Schoolbook all have serifs. The Arial and Helvetica fonts do not have serifs, so they’re referred to as sans serif fonts ("sans serif" is just French for "without serifs").

**A Font’s x-height**

You may also want to consider the heights of a fonts’ lowercase characters relative to their point size. This is referred to as the font’s x-height. It turns out that the Symbol font’s lowercase characters are about 10% taller than those in the Times font, but are roughly the same height as those in the Bookman font. For this reason, some people may think that $\sigma x + \tau z$ (Symbol and Bookman) looks
better than $\sigma x + \tau z$ (Symbol and Times). The Euclid and Euclid Symbol fonts supplied with MathType also solve this problem, since they are specifically designed to match in x-height and overall appearance: $\sigma x + \tau z$.

**Use the Euclid Fonts for a \TeX\ Computer Modern Look**

The \TeX\ system was created by Donald Knuth in the late 1970’s to typeset math books. It is a powerful, but very hard to use, tool that produces high-quality printed output. \TeX\ and \LaTeX\ systems typically use a family of fonts called Computer Modern, and some people like the distinctive appearance these produce.

MathType comes with a family of fonts called Euclid, consisting of 16 individual fonts with 6 different character sets, that have the Computer Modern look. These fonts contain the characters used in the \TeX\ typesetting system, but they are arranged in each font to work optimally with MathType and other Windows applications. Appendix A contains charts that display every character in the Euclid family of fonts.

MathType also comes with an equation preference file called TeXLook.eqp, which sets up MathType to use the Euclid fonts, and also contains spacing settings that match \TeX\’s spacing. This file is located in the Preferences folder inside your MathType folder.

**Fonts as Sources of Additional Symbols**

You may need to use special mathematical symbols that are not available within MathType. Vast numbers of fonts are available for Windows, but only a few of them contain any useful mathematical symbols. The best way to examine fonts for suitable characters is to use the Insert Symbol command on MathType’s Edit menu.

The Insert Symbol command allows you to view all the fonts installed on your computer. You can choose Font in the “View by” list if you think you know which font might have the symbol you’re looking for, or choose Description in the “View by” list to search for the character based on word(s) in its description. The following section contains more information about this command.

The MathType web site, [www.mathtype.com](http://www.mathtype.com), may contain information on other mathematical fonts, the characters they contain, and where they can be obtained.
MathType’s Font and Character Knowledge

MathType has a built-in database containing a considerable amount of knowledge on fonts and the characters they contain. For each font, this knowledge consists of:

- A list of the characters it contains.
- Its PostScript font name, used for generating EPS files.

For each character, which may be a member of several fonts, this knowledge consists of:

- Its description (“Less-than or equal”, for example).
- Its usual role in mathematical equations (“variable” or “relational operator”, for example).
- The preferred MathType style to use when inserted into an equation.

Unicode and MTCode

A key component in MathType’s representation of its font and character knowledge is its use of Unicode. Unicode is a system that assigns an integer value to every character used in the written languages of the world, plus many characters that are in use in mathematics and other technical disciplines.

The bad news on Unicode is that it doesn’t come very close to having assignments for all the characters in use in math and science. The good news is that the Unicode Standard provides a Private Use Area — a range of values that can be used by companies like Design Science to assign as they see fit. We have extended Unicode by adding all the “missing” math and science characters and have named it MTCode. MTCode is a superset of Unicode that MathType uses internally to represent all the characters that are used in its equations.

Some examples may help to make the MTCode idea more concrete. Here are the MTCode values for a few characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>MTCode value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0x0041</td>
</tr>
<tr>
<td>€ (the new Euro currency symbol)</td>
<td>0x20AC</td>
</tr>
<tr>
<td>↑</td>
<td>0x2191</td>
</tr>
<tr>
<td>≦</td>
<td>0xE932</td>
</tr>
</tbody>
</table>

A few things to note about these examples:

- The values are shown in hexadecimal (base-16) notation. This is customary in the Unicode world.
- The value for A is the same as its value in ASCII, a standard that has been in use for many years to represent characters in computers.
• The first three examples are part of Unicode — the last is part of MathType’s extension to Unicode, MTCode.

**Font Encodings**

Many fonts on your computer share the same arrangement of characters. For example, in your word processor when you press the “A” key you get the first letter of the Latin alphabet whether your current font is Arial or Times New Roman. Similarly, hitting the same key when the current font is Symbol or Euclid Symbol will give you a Greek alpha. The concept of “font encoding” is used to capture these relationships. Another common term that means the same thing is “character set”.

In MathType, a font encoding is a named table of MTCode values, one for each position in the fonts that share the encoding. You can see the encoding MathType has assigned to each font on your computer by using the Insert Symbol command on the Edit menu.

**The Insert Symbol Dialog**

Using the Insert Symbol dialog, you can browse all the fonts available on your computer. This is also the best place to see MathType’s font and character knowledge.

Once you select a font in the “View by” section at the top of the dialog, you can see the font’s encoding. For the character selected in the grid, you can also see its
Unicode (MTCode) value, position in the font, the keystroke (if any) that can be used to type it, and its description.

Tutorial 12 in Chapter 4 shows how to use this dialog, and additional information is also contained in MathType’s online Help.

**Extending MathType's Font and Character Knowledge**

Although MathType contains most math characters in MTCode and has encodings for most fonts that are useful in math and science, it will always be incomplete as mathematicians invent new characters and notations and font designers create new fonts. For this reason, we have designed MathType to be easily extended to handle new characters, fonts, and font encodings. However, the details on how to do this are beyond the scope of this manual. You can find this information on our web site, [www.mathtype.com](http://www.mathtype.com), in a document called “Extending MathType's Font and Character Knowledge”.

**Tabs**

MathType’s tabs work roughly the same as those found in most popular word processing applications. You choose the type of tab you want by clicking its button on the Ruler. There are five tab stop types to choose from:

- 📅 Left tab
- 📅 Center tab
- 📅 Right tab
- 📅 Relational tab
- 📅 Decimal tab

Click one of the five buttons to choose the tab stop type, and then click in the area below the Ruler scale to set the position of the tab stop.

Each slot in an equation has its own tab stops. If you press ENTER within a slot or at the end of a line, you create a pile. The same tab stops apply to every line in the pile. The Ruler shows only the tab stops belonging to the current slot or pile (the one containing the selection or insertion point). To remove a tab stop, drag it downwards away from the Ruler. To change the location of an existing tab stop, just drag it along the Ruler. The small inverted T marks on the Ruler are default tab stops.

**Effects of Tab Characters**

Pressing `CTRL+TAB` will insert a tab character into your equation. If you just press the `TAB` key, this moves the insertion point, so to enter tab characters you must
hold down the Ctrl key. Tab characters inserted in this way divide the items in a line into several groups, called tab groups. Each group is bordered by a tab character at each end, except the last group in the line, which has a tab to its left and extends to the end of the line. The formatting of each of these tab groups is controlled by the corresponding tab stop: the first tab stop controls the first group, the second tab stop controls the second group, and so on. Specifically, MathType moves the entire tab group horizontally until some reference position within it is aligned directly below the corresponding tab stop. The reference position that's used is determined by the type of tab stop. For example, if the tab stop is a left tab, then the left end of the tab group is used as the reference position, and is therefore aligned with the tab stop. For other types of tab stops, reference positions are determined as follows:

<table>
<thead>
<tr>
<th>Type of Tab Stop</th>
<th>Reference Position in Tab Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Left end of group</td>
</tr>
<tr>
<td>Right</td>
<td>Right end of group</td>
</tr>
<tr>
<td>Center</td>
<td>Center of group</td>
</tr>
<tr>
<td>Decimal</td>
<td>First decimal point in group (or left end)</td>
</tr>
<tr>
<td>Relational</td>
<td>First relational operator in group (or left end)</td>
</tr>
</tbody>
</table>

The decimal point character will be either a period or a comma, depending on your Regional settings in the Windows Control Panel. Relational operators include equals signs, inequality signs like <, >, ≤, ≥, <, >, and other similar symbols, such as ≡, ∼, ≠.

**Alignment Symbols**

The \( \Delta \) symbol on the \( \Delta \) \( \Delta \) palette is an alignment symbol. If you place an alignment symbol within a tab group, then it is automatically used as the reference position for that group, regardless of what type of tab stop you used. In other words, alignment symbols override all other reference positions. Note that this symbol only appears in the equation in the MathType window. It will not appear when printed or in other applications.

**Tabs and Alignment**

In MathType's Format menu, you will see five alignment commands that closely parallel the five tab stop types described above. In some cases, you may be able to use these commands to obtain the formatting you want instead of using tabs. For example, if you simply want to align two equations at their equal signs, you should use the “Align at =” command, rather than a relational tab stop. You should not try to use a combination of tab stops and alignment commands to format the same line. As in a word processor, the two formatting mechanisms interact with each other in rather unpredictable ways, and you are not likely to get the results you want. Tabs of any of the five types will only work predictably in lines that are left-aligned.
## MathType’s Fonts

The following table lists MathType’s fonts. We’ve also listed Symbol although this is font is installed as part of Microsoft Windows, not MathType:

<table>
<thead>
<tr>
<th>Name</th>
<th>Style</th>
<th>Encoding</th>
<th>PostScript name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol</td>
<td>plain</td>
<td>Symbol</td>
<td>Symbol</td>
</tr>
<tr>
<td>MT Extra</td>
<td>plain</td>
<td>MTEextra</td>
<td>MT-Extra</td>
</tr>
<tr>
<td>Euclid Symbol</td>
<td>plain</td>
<td>Symbol</td>
<td>EuclidSymbol</td>
</tr>
<tr>
<td></td>
<td>italic</td>
<td></td>
<td>EuclidSymbol-Italic</td>
</tr>
<tr>
<td></td>
<td>bold</td>
<td></td>
<td>EuclidSymbol-Bold</td>
</tr>
<tr>
<td></td>
<td>bold-italic</td>
<td></td>
<td>EuclidSymbol-BoldItalic</td>
</tr>
<tr>
<td>Euclid</td>
<td>plain</td>
<td>WinANSI</td>
<td>Euclid</td>
</tr>
<tr>
<td></td>
<td>italic</td>
<td></td>
<td>Euclid-Italic</td>
</tr>
<tr>
<td></td>
<td>bold</td>
<td></td>
<td>Euclid-Bold</td>
</tr>
<tr>
<td></td>
<td>bold-italic</td>
<td></td>
<td>Euclid-BoldItalic</td>
</tr>
<tr>
<td>Euclid Extra</td>
<td>plain</td>
<td>MTEextra</td>
<td>EuclidExtra</td>
</tr>
<tr>
<td></td>
<td>bold</td>
<td></td>
<td>EuclidExtra-Bold</td>
</tr>
<tr>
<td>Euclid Fraktur</td>
<td>plain</td>
<td>EuclidFraktur</td>
<td>EuclidFraktur</td>
</tr>
<tr>
<td></td>
<td>bold</td>
<td></td>
<td>EuclidFraktur-Bold</td>
</tr>
<tr>
<td>Euclid Math One</td>
<td>plain</td>
<td>EuclidMath1</td>
<td>EuclidMathOne</td>
</tr>
<tr>
<td></td>
<td>bold</td>
<td></td>
<td>EuclidMathOne-Bold</td>
</tr>
<tr>
<td>Euclid Math Two</td>
<td>plain</td>
<td>EuclidMath2</td>
<td>EuclidMathTwo</td>
</tr>
<tr>
<td></td>
<td>bold</td>
<td></td>
<td>EuclidMathTwo-Bold</td>
</tr>
</tbody>
</table>

**Encoding** is the name MathType gives to the particular arrangement of character in the font. Note that Euclid Symbol and Symbol have the same encoding, as does MT Extra and Euclid Extra. **PostScript name** is only significant when working with Encapsulated PostScript files or other PostScript environments.
MathType User Manual

Symbol, plain

Encoding: Symbol
PostScript name: Symbol

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>∨</td>
<td>#</td>
<td>∃</td>
<td>%</td>
<td>&amp;</td>
<td>ə</td>
<td>(</td>
<td>)</td>
<td>*</td>
<td>+</td>
<td>,</td>
<td>−</td>
<td>.</td>
<td>/</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>;</td>
<td>&lt;</td>
<td>=</td>
<td>&gt;</td>
<td>?</td>
</tr>
<tr>
<td>4</td>
<td>≡</td>
<td>A</td>
<td>B</td>
<td>X</td>
<td>∆</td>
<td>E</td>
<td>Φ</td>
<td>Γ</td>
<td>H</td>
<td>I</td>
<td>θ</td>
<td>K</td>
<td>Λ</td>
<td>M</td>
<td>N</td>
</tr>
<tr>
<td>5</td>
<td>Π</td>
<td>Θ</td>
<td>R</td>
<td>Σ</td>
<td>T</td>
<td>Y</td>
<td>ζ</td>
<td>Ω</td>
<td>Ξ</td>
<td>Ψ</td>
<td>Z</td>
<td>[</td>
<td>.</td>
<td>]</td>
<td>⊥</td>
</tr>
<tr>
<td>6</td>
<td>α</td>
<td>β</td>
<td>χ</td>
<td>δ</td>
<td>ε</td>
<td>φ</td>
<td>γ</td>
<td>η</td>
<td>ι</td>
<td>ϕ</td>
<td>κ</td>
<td>λ</td>
<td>μ</td>
<td>ν</td>
<td>ο</td>
</tr>
<tr>
<td>7</td>
<td>π</td>
<td>θ</td>
<td>ρ</td>
<td>σ</td>
<td>τ</td>
<td>υ</td>
<td>ζ</td>
<td>ω</td>
<td>ξ</td>
<td>ψ</td>
<td>ζ</td>
<td>{</td>
<td></td>
<td></td>
<td>}</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>∈</td>
<td>∀</td>
<td>’</td>
<td>≤</td>
<td>/</td>
<td>∞</td>
<td>f</td>
<td>♣</td>
<td>♠</td>
<td>♦</td>
<td>♣</td>
<td>↔</td>
<td>←</td>
<td>→</td>
<td>↓</td>
</tr>
<tr>
<td>B</td>
<td>°</td>
<td>±</td>
<td>′</td>
<td>≥</td>
<td>×</td>
<td>∞</td>
<td>δ</td>
<td>□</td>
<td>÷</td>
<td>≠</td>
<td>≡</td>
<td>≈</td>
<td>…</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>C</td>
<td>≈</td>
<td>∅</td>
<td>⊂</td>
<td>⊃</td>
<td>⊆</td>
<td>⊇</td>
<td>⊕</td>
<td>⊖</td>
<td>⊗</td>
<td>⊘</td>
<td>⊙</td>
<td>⊚</td>
<td>⊛</td>
<td>⊜</td>
<td>⊝</td>
</tr>
<tr>
<td>D</td>
<td>≺</td>
<td>△</td>
<td>©</td>
<td>™</td>
<td>Π</td>
<td>√</td>
<td>¬</td>
<td>∧</td>
<td>∨</td>
<td>↔</td>
<td>←</td>
<td>→</td>
<td>⇒</td>
<td>↓</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>≈</td>
<td>≅</td>
<td>⊂</td>
<td>⊃</td>
<td>⊆</td>
<td>⊇</td>
<td>⊕</td>
<td>⊖</td>
<td>⊗</td>
<td>⊘</td>
<td>⊙</td>
<td>⊚</td>
<td>⊛</td>
<td>⊜</td>
<td>⊝</td>
</tr>
<tr>
<td>F</td>
<td>≈</td>
<td>≅</td>
<td>⊂</td>
<td>⊃</td>
<td>⊆</td>
<td>⊇</td>
<td>⊕</td>
<td>⊖</td>
<td>⊗</td>
<td>⊘</td>
<td>⊙</td>
<td>⊚</td>
<td>⊛</td>
<td>⊜</td>
<td>⊝</td>
</tr>
</tbody>
</table>
**MT Extra, plain**

Encoding: MT Extra  
PostScript name: MT-Extra

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Symbols and characters included in the MT Extra font chart.
Euclid Symbol, plain

Encoding: Symbol
PostScript name: EuclidSymbol

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>∀</td>
<td>#</td>
<td>∃</td>
<td>%</td>
<td>&amp;</td>
<td>ə</td>
<td>(</td>
<td>)</td>
<td>*</td>
<td>+</td>
<td>−</td>
<td>.</td>
<td>/</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>;</td>
<td>&lt;</td>
<td>=</td>
<td>&gt;</td>
<td>?</td>
</tr>
<tr>
<td>4</td>
<td>≅</td>
<td>A</td>
<td>B</td>
<td>X</td>
<td>Δ</td>
<td>E</td>
<td>Φ</td>
<td>Γ</td>
<td>H</td>
<td>I</td>
<td>θ</td>
<td>K</td>
<td>λ</td>
<td>M</td>
<td>N</td>
</tr>
<tr>
<td>5</td>
<td>Π</td>
<td>Θ</td>
<td>Ρ</td>
<td>Σ</td>
<td>T</td>
<td>Y</td>
<td>ζ</td>
<td>Ω</td>
<td>Ξ</td>
<td>Ψ</td>
<td>Ζ</td>
<td>[</td>
<td>:</td>
<td>]</td>
<td>↓</td>
</tr>
<tr>
<td>6</td>
<td>α</td>
<td>β</td>
<td>χ</td>
<td>δ</td>
<td>ε</td>
<td>φ</td>
<td>γ</td>
<td>η</td>
<td>ι</td>
<td>ζ</td>
<td>Ξ</td>
<td>Π</td>
<td>Φ</td>
<td>Ψ</td>
<td>Ω</td>
</tr>
<tr>
<td>7</td>
<td>π</td>
<td>θ</td>
<td>ρ</td>
<td>σ</td>
<td>τ</td>
<td>υ</td>
<td>ϖ</td>
<td>ω</td>
<td>ξ</td>
<td>ψ</td>
<td>ζ</td>
<td>{</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Τ</td>
<td>′</td>
<td>≤</td>
<td>/</td>
<td>∞</td>
<td>f</td>
<td>♣</td>
<td>♠</td>
<td>♥</td>
<td>♦</td>
<td>←</td>
<td>←</td>
<td>→</td>
<td>→</td>
<td>A</td>
</tr>
<tr>
<td>B</td>
<td>°</td>
<td>±</td>
<td>″</td>
<td>≥</td>
<td>×</td>
<td>∞</td>
<td>θ</td>
<td>•</td>
<td>÷</td>
<td>≈</td>
<td>≃</td>
<td>≅</td>
<td>≈</td>
<td>...</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
</tr>
<tr>
<td>D</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
</tr>
<tr>
<td>E</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
</tr>
<tr>
<td>F</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
<td>☞</td>
</tr>
</tbody>
</table>
### Euclid Symbol, italic

Encoding: Symbol
PostScript name: EuclidSymbol-Italic

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>(</td>
<td></td>
<td>|</td>
<td>|</td>
<td>|</td>
<td>|</td>
<td>|</td>
<td>|</td>
<td>|</td>
<td>|</td>
<td>|</td>
<td>|</td>
<td>|</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>;</td>
<td>;</td>
<td>&lt;</td>
<td>&gt;</td>
<td>?</td>
</tr>
<tr>
<td>4</td>
<td>( \equiv )</td>
<td>( \Delta )</td>
<td>( \Theta )</td>
<td>( \Pi )</td>
<td>( \Sigma )</td>
<td>( \Theta )</td>
<td>( \Phi )</td>
<td>( \Gamma )</td>
<td>( \Gamma )</td>
<td>( \H )</td>
<td>( \I )</td>
<td>( \vartheta )</td>
<td>( \K )</td>
<td>( \L )</td>
<td>( \M )</td>
</tr>
<tr>
<td>5</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
<td>( \Re )</td>
</tr>
<tr>
<td>6</td>
<td>( \alpha )</td>
<td>( \beta )</td>
<td>( \chi )</td>
<td>( \delta )</td>
<td>( \varepsilon )</td>
<td>( \phi )</td>
<td>( \gamma )</td>
<td>( \eta )</td>
<td>( \iota )</td>
<td>( \kappa )</td>
<td>( \lambda )</td>
<td>( \mu )</td>
<td>( \nu )</td>
<td>( \omicron )</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>( \pi )</td>
<td>( \theta )</td>
<td>( \rho )</td>
<td>( \sigma )</td>
<td>( \tau )</td>
<td>( \varpi )</td>
<td>( \omega )</td>
<td>( \xi )</td>
<td>( \psi )</td>
<td>( \zeta )</td>
<td>( { )</td>
<td>( } )</td>
<td>( \sim )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>( \forall )</td>
<td>( \exists )</td>
<td>( \not\exists )</td>
<td>( \infty )</td>
<td>( \therefore )</td>
<td>( \because )</td>
<td>( \therefore )</td>
<td>( \therefore )</td>
<td>( \therefore )</td>
<td>( \therefore )</td>
<td>( \therefore )</td>
<td>( \therefore )</td>
<td>( \therefore )</td>
<td>( \therefore )</td>
<td>( \therefore )</td>
</tr>
<tr>
<td>B</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
<td>( \in )</td>
</tr>
<tr>
<td>C</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
<td>( \otimes )</td>
</tr>
<tr>
<td>D</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
<td>( \ominus )</td>
</tr>
<tr>
<td>E</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
<td>( \sum )</td>
</tr>
<tr>
<td>F</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
<td>( \sqrt )</td>
</tr>
</tbody>
</table>
Euclid Symbol, bold

Encoding: Symbol
PostScript name: EuclidSymbol-Bold
## Euclid Symbol, bold-italic

Encoding: Symbol  
PostScript name: EuclidSymbol-BoldItalic

<table>
<thead>
<tr>
<th></th>
<th>( \text{\textasciitilde} )</th>
<th>( \approx )</th>
<th>( \equiv )</th>
<th>( \ltimes )</th>
<th>( \triangleright )</th>
<th>( \rightarrow )</th>
<th>( \leftarrow )</th>
<th>( \leftrightarrow )</th>
<th>( \uparrow )</th>
<th>( \downarrow )</th>
<th>( \updownarrow )</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>( \alpha )</td>
<td>( \beta )</td>
<td>( \chi )</td>
<td>( \delta )</td>
<td>( \varepsilon )</td>
<td>( \phi )</td>
<td>( \gamma )</td>
<td>( \eta )</td>
<td>( \iota )</td>
<td>( \varsigma )</td>
<td>( \varphi )</td>
</tr>
<tr>
<td>B</td>
<td>( \kappa )</td>
<td>( \lambda )</td>
<td>( \mu )</td>
<td>( \nu )</td>
<td>( \xi )</td>
<td>( \psi )</td>
<td>( \zeta )</td>
<td>( \theta )</td>
<td>( \rho )</td>
<td>( \sigma )</td>
<td>( \tau )</td>
</tr>
<tr>
<td>C</td>
<td>( \omega )</td>
<td>( \phi )</td>
<td>( \varphi )</td>
<td>( \chi )</td>
<td>( \psi )</td>
<td>( \Lambda )</td>
<td>( \Omega )</td>
<td>( \Theta )</td>
<td>( \Phi )</td>
<td>( \Sigma )</td>
<td>( \Xi )</td>
</tr>
<tr>
<td>D</td>
<td>( \Pi )</td>
<td>( \Sigma )</td>
<td>( \Delta )</td>
<td>( \Xi )</td>
<td>( \Psi )</td>
<td>( \Omega )</td>
<td>( \Phi )</td>
<td>( \Gamma )</td>
<td>( \Phi )</td>
<td>( \Sigma )</td>
<td>( \Xi )</td>
</tr>
<tr>
<td>E</td>
<td>( \cap )</td>
<td>( \cup )</td>
<td>( \cap )</td>
<td>( \cup )</td>
<td>( \cap )</td>
<td>( \cup )</td>
<td>( \cap )</td>
<td>( \cup )</td>
<td>( \cap )</td>
<td>( \cup )</td>
<td>( \cap )</td>
</tr>
<tr>
<td>F</td>
<td>( \tilde{\text{A}} )</td>
<td>( \tilde{\text{B}} )</td>
<td>( \tilde{\text{C}} )</td>
<td>( \tilde{\text{D}} )</td>
<td>( \tilde{\text{E}} )</td>
<td>( \tilde{\text{F}} )</td>
<td>( \tilde{\text{G}} )</td>
<td>( \tilde{\text{H}} )</td>
<td>( \tilde{\text{I}} )</td>
<td>( \tilde{\text{J}} )</td>
<td>( \tilde{\text{K}} )</td>
</tr>
</tbody>
</table>

---

101
Euclid, plain

Encoding: WinANSI
PostScript name: Euclid

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>! &quot; # $ % &amp; ' ( ) * + , - . /</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0 1 2 3 4 5 6 7 8 9 : ; &lt; = &gt; ?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>@ A B C D E F G H I J K L M N O</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>P Q R S T U V W X Y Z [ \ ] ^ _</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>` a b c d e f g h i j k l m n o</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>p q r s t u v w x y z {</td>
<td>] } ~</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>€ , f „ … † ‡ • ‣ % Ç Ş Š ×OE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>‘ ’ “ ” • – — ~ TM ř › œ Ÿ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>A i é £ ® ¥ § &quot; ® a « ¬ – © –</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>B o ± 2 3 ′ µ ‾ · ° » ¼ ½ ¾ ®</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>C À Á Â Æ Ä Ą Ç È É Ê Ë Ì Í Í</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>D Đ Ñ Ò Ô Õ Ö × Ø Ú Ü Ý Ñ ß</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>E à á â ã æ ç è é ë ì ï ì ñ ï</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>F ð ñ ò ó ô ö õ ø ú û ü ý þ ý</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

102
# Euclid, italic

*Encoding: WinANSI*

*PostScript name: Euclid-Italic*

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>0</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>!</td>
<td>&quot;</td>
<td>#</td>
<td>$</td>
<td>%</td>
<td>^</td>
<td>&amp;</td>
<td>'</td>
<td>(</td>
<td>)</td>
<td>*</td>
<td>+</td>
<td>,</td>
<td>-</td>
<td>.</td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>:</td>
<td>;</td>
<td>&lt;</td>
<td>=</td>
<td>&gt;</td>
<td>?</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>@</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td>[</td>
<td>\</td>
<td>]</td>
<td>^</td>
<td>_</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>a</td>
<td>b</td>
<td>c</td>
<td>d</td>
<td>e</td>
<td>f</td>
<td>g</td>
<td>h</td>
<td>i</td>
<td>j</td>
<td>k</td>
<td>l</td>
<td>m</td>
<td>n</td>
<td>o</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>p</td>
<td>q</td>
<td>r</td>
<td>s</td>
<td>t</td>
<td>u</td>
<td>v</td>
<td>w</td>
<td>x</td>
<td>y</td>
<td>z</td>
<td>{</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>€</td>
<td>,</td>
<td>f</td>
<td>”</td>
<td>…</td>
<td>†</td>
<td>‡</td>
<td>‡</td>
<td>^</td>
<td>□</td>
<td>○</td>
<td>ø</td>
<td>ø</td>
<td>ø</td>
<td>ø</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>«</td>
<td>—</td>
<td>™</td>
<td>Š</td>
<td>‹</td>
<td>Œ</td>
<td>Œ</td>
<td>Œ</td>
<td>Œ</td>
<td>Œ</td>
<td>Œ</td>
<td>Œ</td>
<td>Œ</td>
<td>Œ</td>
<td>Œ</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
<td>À</td>
</tr>
<tr>
<td>B</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
<td>Á</td>
</tr>
<tr>
<td>D</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
<td>É</td>
</tr>
<tr>
<td>E</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td>Ñ</td>
<td></td>
</tr>
</tbody>
</table>
Euclid, bold

Encoding: WinANSI
PostScript name: Euclid-Bold

```
<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>&quot;</td>
<td>#</td>
<td>$</td>
<td>%</td>
<td>&amp;</td>
<td>'</td>
<td>(</td>
<td>)</td>
<td>*</td>
<td>+</td>
<td>,</td>
<td>-</td>
<td>.</td>
<td>/</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>:</td>
<td>;</td>
<td>&lt;</td>
<td>=</td>
<td>&gt;</td>
</tr>
<tr>
<td>4</td>
<td>@</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
</tr>
<tr>
<td>5</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td>[</td>
<td>]</td>
<td>^</td>
<td>_</td>
</tr>
<tr>
<td>6</td>
<td>`</td>
<td>a</td>
<td>b</td>
<td>c</td>
<td>d</td>
<td>e</td>
<td>f</td>
<td>g</td>
<td>h</td>
<td>i</td>
<td>j</td>
<td>k</td>
<td>l</td>
<td>m</td>
<td>n</td>
</tr>
<tr>
<td>7</td>
<td>p</td>
<td>q</td>
<td>r</td>
<td>s</td>
<td>t</td>
<td>u</td>
<td>v</td>
<td>w</td>
<td>x</td>
<td>y</td>
<td>z</td>
<td>{</td>
<td></td>
<td>}</td>
<td>~</td>
</tr>
<tr>
<td>8</td>
<td>€</td>
<td>,</td>
<td>f</td>
<td>”</td>
<td>„</td>
<td>‚</td>
<td>„</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
</tr>
<tr>
<td>9</td>
<td>‘</td>
<td>’</td>
<td>‘</td>
<td>&quot;</td>
<td>&quot;</td>
<td>’</td>
<td>’</td>
<td>’</td>
<td>’</td>
<td>’</td>
<td>’</td>
<td>’</td>
<td>’</td>
<td>’</td>
<td>’</td>
</tr>
<tr>
<td>A</td>
<td>i</td>
<td>é</td>
<td>£</td>
<td>®</td>
<td>¥</td>
<td>®</td>
<td>£</td>
<td>®</td>
<td>£</td>
<td>®</td>
<td>£</td>
<td>®</td>
<td>£</td>
<td>®</td>
<td>£</td>
</tr>
<tr>
<td>B</td>
<td>o</td>
<td>±</td>
<td>²</td>
<td>¢</td>
<td>μ</td>
<td>¶</td>
<td>·</td>
<td>„</td>
<td>¹</td>
<td>²</td>
<td>°</td>
<td>′</td>
<td>″</td>
<td>′</td>
<td>″</td>
</tr>
<tr>
<td>C</td>
<td>À</td>
<td>Á</td>
<td>Â</td>
<td>ã</td>
<td>À</td>
<td>ã</td>
<td>À</td>
<td>ã</td>
<td>À</td>
<td>ã</td>
<td>À</td>
<td>ã</td>
<td>À</td>
<td>ã</td>
<td>À</td>
</tr>
<tr>
<td>D</td>
<td>Ð</td>
<td>Ñ</td>
<td>Ò</td>
<td>Ó</td>
<td>Ô</td>
<td>Ô</td>
<td>Õ</td>
<td>Õ</td>
<td>Õ</td>
<td>Õ</td>
<td>Õ</td>
<td>Õ</td>
<td>Õ</td>
<td>Õ</td>
<td>Õ</td>
</tr>
<tr>
<td>E</td>
<td>â</td>
<td>à</td>
<td>ã</td>
<td>ã</td>
<td>â</td>
<td>ã</td>
<td>à</td>
<td>ã</td>
<td>à</td>
<td>ã</td>
<td>à</td>
<td>ã</td>
<td>à</td>
<td>ã</td>
<td>à</td>
</tr>
<tr>
<td>F</td>
<td>ð</td>
<td>ñ</td>
<td>ÿ</td>
<td>ÿ</td>
<td>ð</td>
<td>ÿ</td>
<td>ð</td>
<td>ÿ</td>
<td>ð</td>
<td>ÿ</td>
<td>ð</td>
<td>ÿ</td>
<td>ð</td>
<td>ÿ</td>
<td>ð</td>
</tr>
</tbody>
</table>
```

## Euclid, bold-italic

Encoding: WinANSI  
PostScript name: Euclid-BoldItalic

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>&quot;</td>
<td>#</td>
<td>$</td>
<td>%</td>
<td>&amp;</td>
<td>'</td>
<td>(</td>
<td>)</td>
<td>*</td>
<td>+</td>
<td>,</td>
<td>-</td>
<td>.</td>
<td>/</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>:</td>
<td>;</td>
<td>&lt;</td>
<td>=</td>
<td>&gt;</td>
</tr>
<tr>
<td>4</td>
<td>@</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
</tr>
<tr>
<td>5</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td>[</td>
<td>\</td>
<td>]</td>
<td>^</td>
</tr>
<tr>
<td>6</td>
<td>`</td>
<td>a</td>
<td>b</td>
<td>c</td>
<td>d</td>
<td>e</td>
<td>f</td>
<td>g</td>
<td>h</td>
<td>i</td>
<td>j</td>
<td>k</td>
<td>l</td>
<td>m</td>
<td>n</td>
</tr>
<tr>
<td>7</td>
<td>p</td>
<td>q</td>
<td>r</td>
<td>s</td>
<td>t</td>
<td>u</td>
<td>v</td>
<td>w</td>
<td>x</td>
<td>y</td>
<td>z</td>
<td>{</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>€</td>
<td>,</td>
<td>f</td>
<td>„</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
<td>‚</td>
</tr>
<tr>
<td>9</td>
<td>‘</td>
<td>’</td>
<td>“</td>
<td>”</td>
<td>.</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>A</td>
<td>©</td>
<td>a</td>
<td>«</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>B</td>
<td>°</td>
<td>±</td>
<td>²</td>
<td>³</td>
<td>µ</td>
<td>¶</td>
<td>†</td>
<td>‡</td>
<td>•</td>
<td>′</td>
<td>″</td>
<td>‴</td>
<td>″</td>
<td>‴</td>
<td>″</td>
</tr>
<tr>
<td>C</td>
<td>À</td>
<td>Á</td>
<td>À</td>
<td>Ä</td>
<td>À</td>
<td>Æ</td>
<td>Ç</td>
<td>È</td>
<td>É</td>
<td>È</td>
<td>Ë</td>
<td>Ë</td>
<td>Ë</td>
<td>Ë</td>
<td>Ë</td>
</tr>
<tr>
<td>D</td>
<td>Ð</td>
<td>Ñ</td>
<td>Ô</td>
<td>Ô</td>
<td>Ô</td>
<td>Ø</td>
<td>×</td>
<td>Ø</td>
<td>Ù</td>
<td>Ù</td>
<td>Ù</td>
<td>Ü</td>
<td>Ü</td>
<td>Ü</td>
<td>Ý</td>
</tr>
<tr>
<td>E</td>
<td>ä</td>
<td>é</td>
<td>à</td>
<td>ä</td>
<td>à</td>
<td>æ</td>
<td>ç</td>
<td>è</td>
<td>é</td>
<td>è</td>
<td>é</td>
<td>i</td>
<td>i</td>
<td>i</td>
<td>i</td>
</tr>
<tr>
<td>F</td>
<td>ð</td>
<td>ŏ</td>
<td>õ</td>
<td>õ</td>
<td>õ</td>
<td>ò</td>
<td>õ</td>
<td>õ</td>
<td>ò</td>
<td>õ</td>
<td>õ</td>
<td>ŏ</td>
<td>ŏ</td>
<td>ŏ</td>
<td>ŏ</td>
</tr>
</tbody>
</table>

0 1 2 3 4 5 6 7 8 9 A B C D E F
Euclid Extra, plain

Encoding: MTExtra
PostScript name: EuclidExtra

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

...
### Euclid Extra, bold

**Encoding:** MTExtra  
**PostScript name:** EuclidExtra-Bold

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **fi**: 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
- **fl**: 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
Euclid Fraktur, plain

Encoding: EuclidFraktur
PostScript name: EuclidFraktur

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>&quot;</td>
<td>#</td>
<td>$</td>
<td>%</td>
<td>&amp;</td>
<td>'</td>
<td>(</td>
<td>)</td>
<td>.</td>
<td>+</td>
<td>,</td>
<td>-</td>
<td>.</td>
<td>/</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>;</td>
<td>&lt;</td>
<td>=</td>
<td>&gt;</td>
<td>?</td>
</tr>
<tr>
<td>4</td>
<td>@</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
</tr>
<tr>
<td>5</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td>[</td>
<td>\</td>
<td>]</td>
<td>^</td>
</tr>
<tr>
<td>6</td>
<td>`</td>
<td>a</td>
<td>b</td>
<td>c</td>
<td>d</td>
<td>e</td>
<td>f</td>
<td>g</td>
<td>h</td>
<td>i</td>
<td>j</td>
<td>k</td>
<td>l</td>
<td>m</td>
<td>n</td>
</tr>
<tr>
<td>7</td>
<td>p</td>
<td>q</td>
<td>r</td>
<td>s</td>
<td>t</td>
<td>u</td>
<td>v</td>
<td>w</td>
<td>x</td>
<td>y</td>
<td>z</td>
<td>{</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Euclid Fraktur, bold**

Encoding: EuclidFraktur
PostScript name: EuclidFraktur-Bold

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>&quot;</td>
<td>#</td>
<td>$</td>
<td>%</td>
<td>&amp;</td>
<td>'</td>
<td>(</td>
<td>)</td>
<td>*</td>
<td>+</td>
<td>,</td>
<td>-</td>
<td>.</td>
<td>/</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>:</td>
<td>;</td>
<td>&lt;</td>
<td>=</td>
<td>&gt;</td>
</tr>
<tr>
<td>4</td>
<td>@</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
</tr>
<tr>
<td>5</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td>[</td>
<td>\</td>
<td>]</td>
<td>^</td>
</tr>
<tr>
<td>6</td>
<td>\</td>
<td>a</td>
<td>b</td>
<td>c</td>
<td>d</td>
<td>e</td>
<td>f</td>
<td>g</td>
<td>h</td>
<td>i</td>
<td>j</td>
<td>j</td>
<td>k</td>
<td>l</td>
<td>m</td>
</tr>
<tr>
<td>7</td>
<td>p</td>
<td>q</td>
<td>r</td>
<td>s</td>
<td>t</td>
<td>u</td>
<td>v</td>
<td>w</td>
<td>x</td>
<td>y</td>
<td>z</td>
<td>{</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Euclid Math One, plain

Encoding: EuclidMath1
PostScript name: EuclidMathOne

<p>| | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

0123456789ABCDEF0123456789ABCDEF0123456789ABCDEF0123456789ABCDEF0123456789ABCDEF
## Euclid Math One, bold

**Encoding:** EuclidMath1  
**PostScript name:** EuclidMathOne-Bold

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Euclid Math Two, plain

Encoding: EuclidMath2
PostScript name: EuclidMathTwo

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td>Δ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
<td>O</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>k</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Euclid Math Two, bold

Encoding: EuclidMath2  
PostScript name: EuclidMathTwo-Bold

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>△</td>
<td>▽</td>
<td>▼</td>
<td>▼</td>
<td>▲</td>
<td>▲</td>
<td>▼</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
<td>O</td>
</tr>
<tr>
<td>5</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>&lt;</td>
<td>&gt;</td>
<td>&lt;</td>
<td>&gt;</td>
<td>&lt;</td>
<td>&gt;</td>
<td>&lt;</td>
<td>&gt;</td>
<td>&lt;</td>
<td>&gt;</td>
<td>&lt;</td>
<td>&gt;</td>
<td>&lt;</td>
<td>&gt;</td>
<td>&lt;</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Index

A
Adobe Acrobat, 71
Adobe PageMaker, 63, 65, 74, 75
Adobe Type Manager, 6
Alignment, 50
- at =, 36
- at decimal points, 50
- center, 36
- commands, 94
- fences, 87
- matrices, 38
- right, 36
- symbol, 36, 94
- using tabs, 93
AMS-LaTeX, 58
AMS-TeX, 58
Anti-aliasing, 53, 54
Arrow keys, 12, 14
ATM, 6
Automatic style assignment, 79

B
Bar embellishment, 25
Bars, 11
Baseline of an equation, 64
Binary operators, 38
Bold type, 37, 79
Braces, 24
Brackets, 86
- aligning, 87

C
Cascading Style Sheets, 71
Change Matrix command, 38
Character formatting, 88, 89
Character style, 77
- explicit assignment, 80
Character substitution, 80
Clipboard, 61
Color, 75
Computer Modern fonts, 90
CSS, 71
CTRL key, 17
Curly brackets, 24
Customize Keyboard, 55

D
Default Preferences, 84
Define Sizes command, 74
Define Spacing command, 87
Define Styles command, 39
Definite integral, 34
Delete key, 12
Design Science, 4
Disks, floppy, 5
Double-click
- editing equations, 27
Double-click selection, 16
Drag-and-Drop, 37, 63
Drawing programs, 73

E
Edit Color Menu command, 75
Editing equations in documents, 27
Embellishments
- inserting, 25
- selecting, 26
Encapsulated PostScript, 61, 63
Enter key, 12, 14
EPS files, 2, 63, 65
- importing, 66
- moving between platforms, 75
Equation
- aligning with text, 64
- baseline, 64
- editing, 27
- importing as file, 65
- inline, 44
- inserting in documents, 30
- preferences, 69
- resizing, 64
- saving in file, 63
Equation Conversion Manager, 7
Equation Editor, 7
Equation numbers, 43
Equation Numbers, 65, 68
Equation numbers, format, 45, 68
Equation references, 44
Equation Section Break, 45
Equation sections, 45
Euclid fonts, 40, 90
- Euclid Math Two, 52
- Euclid Symbol, 52
Explicit style assignments, 80, 82
F
Fence Alignment command, 87
File numbering, 66
Files
   EPS. See EPS files
   GIF. See GIF files
   PDF. See PDF files
   TIFF. See TIFF files
   WMF. See WMF files
Floppy disks, 5
Foils, 74
Font encodings, 52, 92, 95
   Euclid Extra, bold, 107
   Euclid Extra, plain, 106
   Euclid Fraktur, bold, 109
   Euclid Fraktur, plain, 108
   Euclid Math One, bold, 111
   Euclid Math One, plain, 110
   Euclid Math Two, bold, 113
   Euclid Math Two, plain, 112
   Euclid Symbol, bold, 100
   Euclid Symbol, bold-italic, 101
   Euclid Symbol, italic, 99
   Euclid Symbol, plain, 98
   Euclid, bold, 104
   Euclid, bold-italic, 105
   Euclid, italic, 103
   Euclid, plain, 102
   MT Extra, plain, 97
   Symbol, plain, 96
Fonts, 6, 39, 91
   as sources of symbols, 90
   blackboard bold characters, 90
   choosing appropriate, 89
   Computer Modern, 90
   Euclid family, 40, 52, 84, 90
   explicit assignment, 80
   gothic characters, 90
   primary, 40, 77, 84
   supplied with MathType, 95
   used in styles, 77
Formatting equations. See Spacing
Fraction bar overhang, 82
Fractions, 20
   case, 21
   full-size, 21
   reduced-size, 21
Full typesize, 74, 81
Function recognition, 29, 79
Function style, 28, 78
G
GIF files, 2, 53, 65, 66, 71
   moving between platforms, 75
Gothic characters, 90
Greek characters, 23, 33
Greek style, 78
H
Hardware, 5
Help, 3, 4
HTML, 53
   baseline adjustment, 71
   HTML code, 71
   Hyphen, 80
I
Importing equations
   as files, 65
Inline equation, 44, 64
Insert Object command, 62, 73
Insert Symbol command, 51, 88, 90, 92
Inserting equations
   into documents, 62
   using Cut & Paste, 63
   using Drag-and-Drop, 63
Insertion point, 10
   moving, 14, 15
Installing MathType, 5
Integrals, 34
   expanding, 34
Intervals, 86
Italic characters, 78
K
Kerning, 87
Keyboard notation, 12
Keyboard shortcuts, 17, 55
   spaces, 85
   style of next character, 79
   styles, 80, 82
   symbols, 13
   symbols in other fonts, 53
   templates, 14
   two-key shortcuts, 17
L
Large Tabbed Bar, 31
Larger command, 89
LaTeX, 56, 72
Index

Leading, 36
Lim sup, 35
Line spacing, 36, 47, 70

M
Macintosh, 75
Markup languages, 56, 72
Math style, 77, 79
MathML, 56, 58, 72
MathType Server, 61
icon, 61
MathType toolbar, 11
MathType window, 10
Matrices, 36, 37
editing, 38
Metafiles. See WNF files
Microsoft PowerPoint, 74
Microsoft Word, 7, 67
converting documents to TeX, 72
EQ fields, 69
line spacing, 70
moving documents between computers, 70
setting up documents, 46
styles, 46
Microsoft Word commands, 67
converting equations, 69
equation number format, 68
equation numbering, 68
equation numbering example, 43
equation section example, 45
equation sections, 68
formatting equations, 48
insert equation reference, 44
inserting equations, 67
setting equation preferences, 47, 69
Minus sign, 22
unary, 39
Moving equations between platforms, 75

N
Nudge commands, 26, 86
resetting, 87
Number style, 79
Numbering equations, 43, 65, 68
Numbering files, 66
Numerator height, 82

O
Object Linking and Embedding. See OLE
OLE, 61, 62
Inserting objects, 62
start MathType in server mode, 62
Operators
unary and binary, 38
Overheads, 74
Overstrikes, 87

P
PageMaker. See Adobe PageMaker
Pantone, 75
PDF files, 71
Pile, 16, 35
PostScript fonts, 6
Preference files
installed, 84
loading, 84
saving, 83
TeX appearance, 84
Presentation applications, 74
Primary font, 40, 77, 84

Q
QuarkXPress, 63, 65, 74, 75

R
Recognition of functions, 79
References to equations, 44
Reset Nudge command, 87
Resizing
equations, 64
fences, 89
summation signs, 89
Return key, 12, 16
Ruler, 12, 49, 93

S
Saving preference files, 83, 84
Section numbers, 45
Sections, 45
Selecting
brackets and braces, 16
double-clicking, 16
embellishments, 16
items in an equation, 16
summation and integral signs, 16
with the Arrow keys, 16
Selection, 10
Server, 61
Show All, 49
Size
  Full, 81
  of individual characters, 89
  Other, 89
  Subscript, 81
  Sub-subscript, 81
  Sub-symbol, 81
  symbol, 81
  User 1 and User 2, 82
Slides, 74
Slot, 10
Small Bar, 30
Smaller command, 89
Space symbols, 85
SPACEBAR, 13
Spacing
  advanced formatting, 85
  automatic, 20
  between lines, 36, 47
  defining, 82
  em space, 34
  in Preference files, 84
  inserting spaces, 34
Square roots, 20
Status Bar, 10, 80
Style, 77
  automatic assignment, 79
  character, 77
  Define Styles dialog, 39
  explicit assignment, 80, 82
  factory settings, 42
  Function, 28, 41, 78
  Greek, 78
  in Preference files, 84
  Math, 77
  Number, 79
  one-character shortcuts, 80
  Other, 88
  Symbol, 78
  Text, 78
  User 1 and User 2, 79
  Variable, 42, 78
  Vector-Matrix, 37, 79
Style definitions
  saving and loading, 83
  Styles, 39, 46
  Subscript depth, 82
  Subscript typesize, 81
Sub-subscript typesize, 81
Sub-symbol typesize, 81
Symbol Palettes, 11
Symbol style, 78
Symbol typesize, 81
Symbols
  additional, 90
  searching for, 52
System requirements, 5

T
Tab
  character, 93
  groups, 94
  key, 14
Tab Stops, 93
TDL files, 59
Techexplorer, 59
Technical Support, 4
Template Palettes, 11
Templates
  exponent, 22
  inserting, 14
  replace selection vs. wrapping, 32
  superscripts, 22
TeX, 56, 72
  AMS-LaTeX, 58
  AMS-TeX, 58
TeX appearance, 90
Text
  in equations, 28
  style, 49, 78
  typing, 12
TIFF files, 66
Toolbar, 11
  changing size of icons, 12
  customizing, 31
  deleting items, 33
  docking and floating, 11
  editing expressions, 31
  keyboard shortcuts, 33
  rearranging contents, 32
Translator Definition Language, 59
Translators, 56, 72
  modifying, 59
Typesize, 81
  Full, 81
  of individual characters, 89
  Subscript, 81
  Sub-subscript, 81
  Sub-symbol, 81
Symbol, 81
User 1 and User 2, 82
Typesizes
  in Preference files, 84
Typing, 12

U
Unary operators, 38
Undo command, 19
Unicode, 91
Unit abbreviations, 83
Units of measurement, 83
Update Equation Numbers command, 45
User 1 and User 2 styles, 79
User 1 and User 2 typesizes, 82

V
Variable style, 42, 78
Vector-Matrix style, 37, 79
Vertical bar symbols, 86
Vertical bar template, 37
View-graphs, 74

W
Web pages, 53, 58, 63, 66, 71
Web site (MathType), 4
WebEQ, 59
Windows 95, 5
Windows 98, 5
Windows metafiles. See WMF files
Windows NT, 5
WMF files, 2, 61, 63, 65
Word. See Microsoft Word
WordPerfect equation, 61
World Wide Web, 53, 71

X
XML, 58